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About This Quick Start Guide

This guide steps you through the following;:

1. Setting up Novell Filr with test users and data on a Windows/Active Directory network.

2. Briefly exploring Novell Filr administration and user functionality.

A lab network is the assumed target environment, but the instructions can be adapted for installing
Filr on a production network if desired.

¢ Chapter 1, “Small Versus Large Filr Deployments,” on page 7

¢ Chapter 2, “Hands-on System Requirements,” on page 9

¢ Chapter 3, “Downloading Filr Software,” on page 13

¢ Chapter 4, “Creating Test Users,” on page 17

¢ Chapter 5, “Preparing Folders and Files,” on page 21

¢ Chapter 6, “Deploying and Configuring the Filr Appliances,” on page 47

¢ Chapter 7, “Securing LDAP Communications between Filr and Active Directory,” on page 69

¢ Chapter 8, “Administering Filr,” on page 77

¢ Chapter 9, “Using Filr,” on page 101

Audience

This guide is for administrators of Windows/Active Directory networks who want to evaluate Novell
Filr.

Feedback

We want to hear your comments and suggestions about this guide and the other Filr documentation.
Please use the User Comments feature at the bottom of each page of the online documentation.

Documentation Updates

For the most recent version of this guide, access it on the Web (http://www.novell.com/
documentation/novell-filrl/filrl_hands-on_w/data/bookinfo.html).

Additional Documentation

For additional Novell Filr documentation, see the Filr Documentation Web page (http://
www.novell.com/documentation/novell-filrl).

About This Quick Start Guide 5
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Small Versus Large Filr Deployments

Novell Filr can be deployed in the following ways:

¢ As a Small Deployment: A single, multi-purpose Filr appliance

¢ As a Large Deployment: At least three separate, single-purpose appliances (Filr, Filrsearch, and

MySQL)

Either deployment type works for the exercises in this guide, but production environments require
large deployments, and many production workloads require clustered Filr appliances.

Your First Hands-on Task: Choose a Deployment Type

1 Using the information in this section, choose a deployment type for the hands-on exercises that
matches your goals for learning about Filr.

For example, if you only have a casual interest in learning about Filr and want to invest the
minimum time and effort required, a small deployment is the best fit. On the other hand, if you
think you might want to deploy Filr inside your organization, and you want to investigate what
that will require, you should probably consider a large deployment.

¢ Comparison of Deployment Types: The following table summarizes the main differences
between small and large Filr deployments.

Small Deployment

Large Deployment

*

Does not support production environments

*

Supports production environments

*

Maximum capacity is
+ 300 active users
+ 2,500 folders
+ 50,000 files

*

Supports more than
+ 300 active users
+ 2,500 folders
+ 50,000 files

Cannot be upgraded to a large deployment,
and cannot “grow” by leveraging shared,
external storage

If shared storage is configured as part of the
initial configuration, a large deployment can
“grow” to include multiple, clustered Filr
appliances.

IMPORTANT: Shared storage is not
covered in this guide, but a link to that
documentation is provided.

Requires downloading two files: the Filr
appliance and the Hands-on Filr-
windows. zip file

Requires downloading four files: the Filr,
Filrsearch, and MySQL appliances, and the
Hands-on Filr-windows.zip file

Offers a streamlined, quick installation and
configuration

Requires a more involved installation and
configuration

Small Versus Large Filr Deployments
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Small Deployment Large Deployment

+ Uses only one IP address ¢ Requires three IP addresses

+ Cannot access an existing MySQL ¢ Can use an existing MySQL database in
database (all functionality is contained place of the MySQL appliance provided
within the single appliance) with Filr

¢ Both Types Are Covered in This Guide: Where different procedures are required, section
titles begin with “Small Deployment” or “Large Deployment.”

Most of the sections apply to both deployment types.

2 Continue with Chapter 2, “Hands-on System Requirements,” on page 9.
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2.1

Hands-on System Requirements

To set up Filr for the hands-on exercises, ensure that your system meets the requirements for your
deployment type.

¢ Section 2.1, “Small Deployment: System Requirements,” on page 9

¢ Section 2.2, “Large Deployment: System Requirements,” on page 10

Small Deployment: System Requirements

Table 2-1 Small Deployment System Requirements

Item Details

A Windows 2003 R2 or 2008 R2 server that is attached to an Active Directory
domain.

m/ Administrative rights on the server.

Windows Server

Software for the Filr appliance (see Section 3.1, “Small Deployment:
‘I Software,” on page 13)
Filr Software

One of the three virtualization platforms listed in “Filr Server Requirements” in
the Novell Filr 1.0.1 Installation and Configuration Guide:

o * Hyper-V
Virtualization Server + VMware
+ Xen

The virtualization server should have at least the following resources
available for the Filr virtual machines:

¢ 12 GB RAM
+ 125 GB free hard drive space

Filr One IP address on the Active Directory domain network, including:

¢ DNS host name
) ¢ The subnet mask
¢ The primary gateway IP address

One IP Address on
Your network + A DNS server IP address

Hands-on System Requirements
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2.2

Item

Details

my-email1@example.com
my-email2@example.com

Two Email Addresses

Two Web-based email addresses for receiving invitations and notifications

|
3/
Windows Workstation

A Windows workstation for administering the appliances and testing the Filr
Windows application:

*

Enterprise-level (non-home) version of Windows XP, Windows 7, or
Windows 8

Joined to your Active Directory domain

Mozilla Firefox 9, Mozilla Firefox 10, Microsoft Internet Explorer 8, or
Microsoft Internet Explorer 9 for configuring and managing the
appliance after the initial setup

Microsoft Office or LibreOffice

A Java Runtime Environment (JRE)

=
=
©

Wireless Connectivity

Wireless connectivity on your network

=

Mobile Devices

At least one mobile device (iOS 5 or later or Android 2.3 or later) that is
capable of connecting to your network’s wireless connection

Large Deployment: System Requirements

Table 2-2  Large Deployment System Requirements

Item

Details

g

Windows Server

A Windows 2003 R2 or 2008 R2 server that is attached to an Active Directory
domain.

Administrative rights on the server.

1
Filr Software
)
Filrsearch Software

I
MySQL Software

Software for the three Filr appliances: Filr, Filrsearch, and MySQL (see
Section 3.2, “Large Deployment: Software,” on page 14).

Filr 1.0.1 Hands-on Guide for Windows



Item Details

> One of the three virtualization platforms listed in “Filr Server Requirements” in
v ¥ = the Novell Filr 1.0.1 Installation and Configuration Guide:
3 * Hyper-V
Virtualization Server
* VMware
* Xen

The virtualization server should have at least the following resources
available for the Filr virtual machines:

+ 18 GB RAM
+ 250 GB Hard drive free space

Filr Filrsearch ~ MySQL Three IP addresses on the Active Directory domain network for the Filr
i o appliances, including:
' ' ' + |P addresses

Three IP Addresses on * DNS host names
Your network + The subnet mask
+ The primary gateway IP address

+ At least one DNS server IP address

E my-email1@example.com Two Web-based email addresses for receiving invitations and notifications

Two Email Addresses

A Windows workstation for administering the appliances and testing the Filr

;:J Windows application:
\/“ . . . .
Windows Workstation + Enterprise-level (non-home) version of Windows XP, Windows 7, or
Windows 8

+ Joined to your Active Directory domain

* Mozilla Firefox 9, Mozilla Firefox 10, Microsoft Internet Explorer 8, or
Microsoft Internet Explorer 9 for configuring and managing the
appliance after the initial setup

+ Microsoft Office or LibreOffice

¢ A Java Runtime Environment (JRE)

) Wireless connectivity on your network
-
©

Wireless Connectivity

At least one mobile device (iOS 5 or later or Android 2.3 or later) that is
‘1 capable of connecting to your network’s wireless connection
4

N

Mobile Devices

Hands-on System Requirements
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3 Downloading Filr Software

¢ Section 3.1, “Small Deployment: Software,” on page 13
¢ Section 3.2, “Large Deployment: Software,” on page 14

3.1 Small Deployment: Software

1 If you don’t already have a Novell account, register for one on the Novell Web site (https://
secure-www.novell.com/selfreg/jsp/create Account.jsp?).

2 Access the Novell Downloads Web page (http://download.novell.com).
3 Do a keyword search for Novell Filr.

Froduct or Technology [optional |

— Pleaze Selact —
— Select Wersion —

Al Dates

ird [opticonal |

Maovell Filr Evaluation

[=search)

1 Results Found - 1-1  Results per page: mgl

Name - click for description File Hame

Mowell Filr 1.0.1 Evaluation - 100% 12 files 16 Sep 2013 12 files »

5 Continue the download process until you have successfully downloaded the following;:

¢ Hands-on Filr-windows.zip

Downloading Filr Software


https://secure-www.novell.com/selfreg/jsp/createAccount.jsp?
http://download.novell.com

¢ The file for your virtualization platform:

VMware Filr.x86 64-version.ovf.zip

Hyper-V Filr.x86 64-version.vhd.zip

Xen Filr.x86_64-version.xen.tar

6 Continue with Chapter 4, “Creating Test Users,” on page 17.

3.2 Large Deployment: Software

1 If you don’t already have a Novell account, register for one on the Novell Web site (https://
secure-www.novell.com/selfreg/jsp/create Account.jsp?).

2 Access the Novell Downloads Web page (http://download.novell.com).
3 Do a keyword search for Novell Filr.

Froduct or Technology [optional |

— Pleaze Salact —

— Select Wersion —

Al Dates

d [optian

K al)
MNaovell Filr Evaluation

garch]l Login abowet

4 1In the Results section, click the Nowvell Filr Evaluation Download button.

1 Results Found - 1-1 Results per page: mgl L 820 Relevancy u

Hame - click for de=scription File Hame Date Dowwnload

Mowell Filr 1.0.1 Evaluation - 100% 12 files 16 Sep 2013 12 files »

1-1
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5 Continue the download process until you have successfully downloaded the following:
¢ Hands-on Filr-windows.zip

¢ The files for your virtualization platform:

VMware Filr.x86 64-version.ovf.zip
Filrsearch.x86_ 64-version.ovf.zip

MySQL.x86 64-version.ovf.zip

Hyper-V Filr.x86 64-version.vhd.zip
Filrsearch.x86 64-version.vhd.zip

MySQL.x86 64-version.vhd.zip

Xen Filr.x86_64-version.xen.tar
Filrsearch.x86 64-version.xen.tar

MySQL.x86_64-version.xen.tar

6 Continue with Chapter 4, “Creating Test Users,” on page 17.

Downloading Filr Software 15
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Creating Test Users

For information about users and groups in Filr, see “Users and Groups with Filr” in the How Filr

Works—Overview Guide.

The tasks in this guide involve the test users shown in Table 4-1.

Table 4-1 Test Users to Create

First Name Last Name “Z(renreLogon Role in Organization E)eiz?vecl)erd E(())Irg;
A Red ared Development Supervisor Fllrrock$ Yes

A Pink apink Developer Fllrrock$ No

A Blue ablue IT Supervisor Fllrrock$ Yes

A Green agreen Network Technician Fllrrock$ No

A Yellow ayellow Marketing Supervisor Fllrrock$ Yes

A Orange aorange Marketing Administrative Assistant Fllrrock$ No

A Black ablack Director of Sales Fllrrock$ Yes

A Gray agray Sales Representative Fllrrock$ No
Filr Proxyuser filrproxyuser n/a NOv3lifilr No

1 Create an ou container named testusers in your AD domain.

Creating Test Users
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Remote Desktop Services 4
i Active Directory Administrative Center
2, Active Directory Domains and Trusts
le4 Active Directory Module for Windows PowerShell
[z Active Directory Sites and Services

Active Directory Users and Computers
ADSI Edit
g J Motepad L . Component Services

- Computer Management
@ Internet Explorer e

Data Sources (ODBC)
~ - Active Directory Users and Documents Erizs
Computers

a8 Command Prompt 7 :

DNS

Event Viewer

Computer
Group Policy Management
Network Internet Information Services (115) Manager

ISCSI Initiator

Control Panel
Local Security Policy

) [ o7 B (6] e b D) B

Performance Monitor

Devices and Printers

5)_:_nI Security Configuration Wizard
% Administrative Tools 4 _'.:!,_;I Server Manager
" Services
Hel d S t n
ErEELLL '3z Share and Storage Management
Run % Storage Explorer
System Configuration
» All Programs (L) Task Scheduler
Windows Firewall with Advanced Securi
I Search programs and files ¥=) Logoff |» ﬁ =
3| Windows Memory Diagnostic
g ) -
;I. — — e Windows PowerShell Modules
. _Eﬂ lﬂ M= ‘ '@’ Windows Server Backup

Active Directory Users and Comput
Saved Queries

3 firdab.local
| Builtin
| Computers

[+

2| Domain Controllers

| ForeignSecurityPrincipals
| Managed Service Accounts
| Users
ERf testusers
KN I i

TIP: Locating the container at the top of the domain isn’t required, but it makes the path shorter
during the LDAP import.

The use of a separate container simplifies the LDAP import process and the removal of users
when your evaluation concludes.

2 Create the users listed in Table 4-1 in the testusers container and assign them passwords as
indicated in the table and shown in the screen shots that follow.

Users are assigned the same password to simplify the evaluation test process.

The password for the proxy user is the “administrative” password used in the examples in this
guide.
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If the suggested passwords don’t meet your password policy requirements, specify passwords
that do.

IMPORTANT: Make sure that you deselect User must change password at next login as shown.

f Active Directory Users and Comput | Name | Type
| saved Queries
= 3 firab.local

| Builtin

| Computers

2| Domain Controllers

| ForeignSecurityPrincipals

| Managed Service Accounts

:_‘. EE Delegate Control...

1 Us
Move...
Find...

3 Computer
All Tasks 3 Contact
Group
View ' InetOrgPerson
Cut msImaging-FSPs
Delete M3MQ Queue Alias
Rename Organizational Unit
Refresh Printer
Export List...
Shared Folder

Pronertieg

New Object - User |

E. Createin:  filrHab local testusers

First name: Iﬂt Initials: I

Last name: Red

Full name: ||A Red ‘

User logon name:

||E""3'3I | I@filr—lab.local j
User logon name (pre-Windows 2000):
|FILF{-LAE\ Iared
¢ Back Cancel |

Creating Test Users 19



New Object - User

]
r
r
r

MNew Object

3 Ensure that you create all of the users.

ﬁ Active Directory Users and Compu
& [ Saved Queries
B &3 firdab.local

® [ Builtin

= [7] Computers

[ (2| Domain Controllers

ERERERERE

4 Continue with Chapter 5, “Preparing Folders and Files,” on page 21.
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Preparing Folders and Files

Figure 5-1 illustrates the folders and files that are contained in the zip that you downloaded in
Chapter 3, “Downloading Filr Software,” on page 13.

Figure 5-1 Hands-on Files and Folders

( )
Your Windows Server
Drive C:
download
.novell > > Filr Exercise Folders
.com ‘
Hands-on_Filr-Windows.zip
Dev * Home_Folders * IS * Mrktg * Sales *
personnel ablack *** training advertising revenue
reviews ** ablue *** quick_starts ** brochures ** projections **
ink Novell_Filr.pdf filr_flyer.pdf 2014.xls
mpin -
ared quotas **
2013.doc
ayellow *** 2013.xls
salaries **
2014.xls
projects **
current Folders and files are downloaded in the .zip file.
abc-requ.doc *You create Windows Shares for these. Then later you designate
them as Net Folder Servers.
future **These folders become Net Folders with the implementation of Filr.
xyz-requ.doc *** These folders are created by Windows for the users that you create.
. J
¢ Section 5.1, “Unzipping the Exercise Folders and Files,” on page 22
¢ Section 5.2, “Setting Up the Home_Folders Share,” on page 23
¢ Section 5.3, “Assigning Home Folders,” on page 31
¢ Section 5.4, “Setting Up the Other Hands-on Exercise Folders and Files,” on page 34
Preparing Folders and Files 21



5.1 Unzipping the Exercise Folders and Files

1 Copy the Hands-on_Filr-windows.zip file that you downloaded in Chapter 3, “Downloading
Filr Software,” on page 13, to Local Disk (C:) on your Windows server.

& L ocal Disk (C:) 10l =l
= A a
el\ J< ﬁ = Comp... +LlocalDi... = + &3 I Search Local Disk (C:) [ﬂ‘
Organize ¥ 5 Open ¥  New folder 4= = [l @
:I Mame ~ | Date modified | Type
- Libraries
3 Documents J inetpub 7/24/2013 1:26 PM  File folder
J; Music | Perflogs 7/13/2009 9:20PM  File folder
=] Pictures | Program Files 7/24/2013 1:05PM  File folder
E Videos J Program Files (x86) 7/24/2013 1:05PM  File folder
| Users 7/24/2013 11:00 AM  File folder
M
I= Computer | Windows 7/24/2013 1:26 PM  File folder
£, Local Disk ()
¢4 DVD Drive (D:) GRP _ _ _
Ei=i | i
j Fir-Exercise-Folders-w  Date modified: 8/16/2013 2:04 PM
: Compressed (zipped) Folder Size: 80.4KB

2 Right-click the zip file, then select Extract All.

Mame ~ | Date modified | Type
J inetpub 7242013 1:26 PM  File folder
| PerfLogs 7(13/20099:20PM  File folder
| Program Files 7242013 1:05PM  File folder
| Program Files (x86) 7(24/2013 1:05PM  File folder
| Users 7242013 11:00 AM  File folder

J Windows 7242013 1:26 PM  File folder

o sL012 2 04PM  Compressed (|
Open

LI_ Open in new window
Hers-w Extract Al...

ed) Folder Open with. ..

Restore previous versions
- Send tn k

3 Change the extraction path to c:\, then click Extract.
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.l Extract Compressed (Zipped) Folders ﬂ

O 1, Extract Compressed (Zipped) Folders

Select a Destination and Extract Files
Files will be extracted to this folder:

I (&1 Browse... |

¥ Show extracted files when complete

Extract I Cancel

4 Double click the extracted Filr-Exercise-Folders folder to reveal the five directories used in the
exercises that follow.

e
‘@Ov| . = Llocal... = FirEx... - - mll Search Filr-Exerdise-... E]‘

Organize *  Indudeinlibrary +  Sharewith +  Mew folder &= - m @

|| Pictures 7S [ —— | Date modified | Type
™ videos
| Dev 9/5/2013 1:45 PM File folder
=8 Computer | Home_Folders | 8/16/2013 11:53 AM  File folder
= & Local Disk (C:) |15 9/5/2013 1:45 PM File folder
. Filr-Exerdse-Fal J Mrktg 952013 1:45 PM File folder
 inetpub . Sales 9/5/2013 1:45 PM File folder
| PerflLogs
| Program Files LI ‘| | LI

5 Continue with Setting Up the Home_Folders Share.

5.2 Setting Up the Home_Folders Share

¢ Section 5.2.1, “Configuring Home_Folders Share Permissions,” on page 23

¢ Section 5.2.2, “Configuring Home_Folders NTFS Permissions,” on page 27

5.2.1 Configuring Home_Folders Share Permissions

1 On the Windows server, click the Windows Explorer icon El';_’lJ.

2 Navigate to the Home_Folders folder that you downloaded and extracted in Section 5.1,
“Unzipping the Exercise Folders and Files,” on page 22.

Preparing Folders and Files
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_10] |
@ O? | -~ FirEx... = Home_Fol... v m I Search Home_Folders @‘
Organize *  Indudeinlbrary +  Sharewith +  New folder =+ 1 @

=& Local Disk (€2 A Mame - EE— |

= | Filr-Exercise-Folc
, Dev

. Home_Folders
.15
J Mrktg J
. Sales

. inetpub

. PerfLogs
[+ Drrnram Files j ‘I

This folder is empty.

3a Right click the folder.
3b Click Properties.

3 Share Home_Folders by doing the following:

Open in new window

W

Share with

Indude in library

Restore previous versions

Send to

Cut
Copy

Create shortcut
Delete
Rename

Properties

3c Click the Sharing tab, then click Advanced Sharing.

N tome_rolders properties T
" General | Security I Previous Versions I Customize I

— Netwaork File and Folder Sharing

Home_Folders
.} )} Not Shared

Network Path:
Mot Shared

— Advanced Sharing

advanced sharing options.

| '@"Mvanced Sharing... I

Set custom permissions, create multiple shares, and set other

ok |

Cancel Apply

Filr 1.0.1 Hands-on Guide for Windows




3d Select the Share this folder option, name the share Home_Folders$, then click Permissions.
As you probably know, the dollar sign ($) hides the folder from users browsing the

network.

Share this folder

X

Settings

Share name:

I Home_Folderss

Adld | Remove |

Limit the number of simultaneous users to:

Comments:

Caching |

Permissions I

Cancel |

o]

Appl?l

4 Configure group permissions by doing the following;:

4a Click Remove to remove access by the Everyone group.

I Permissions for Home_Folderss

Share Permissions |

GI'OL.ID Qr User Names:

x|

| Remove I

Add.
Pemissions for Evernyone Allow Deny
Full Cortral O a
Change O a
Read O
Leam about access control and permissions
CK I Cancel Apply

4b Click Add.

Preparing Folders and Files
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n Permissions for Home_Folders$ x|
Share Permissions |
Group or user names:
Mo groups or users have permizsion to access this object. ;I
However, the owner of this object can assign pemissions.
Add... I Eemayve I

Pemissions Allow Deny

Full Control O O

Change O O

Read O O
Leam about access control and permissions

ok | cancd | mpoy |

4c In the Enter the object names to select field, type Domain Users, then click Check Names.

select Users, Computers, Service Accounts, or Groups 2x|

Select this object type:

IUsers, Groups, or Built4in security principals Object Types...
From this location:

Iﬁlr—labJocaI Locations... |

Erter the object names to select (eamples):

Domain Users Checlc Names

Mvanc:ed...l ok | cancel |

P
4d Click OK.
2]
Select this object type:
IUsers. Groups, or Built-in security principals Object Types. .. |
From this location:
Iﬁlr—labJocaI Locations. .. |
Erter the object names to select (eamples):
Domain Users Check Names
Advanced... | oK | Cancel |
P
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4e Under Permissions for Domain Users, Allow full control, then click OK > OK.

M Permissions for Home_Folderss x|

Share Permissions |

Group or user names:
a Domain Users (FILR-LAB“Domain Users)

Add... | Remove |
Pemissions for Domain Users Allow Deny
Full Control O
Change O
Read O

Leam about access control and permissions

™ ok | cancel | Aonty

4f Continue with Configuring Home_Folders NTFES Permissions.

5.2.2  Configuring Home_Folders NTFS Permissions

1 Configure file permissions by doing the following:
la Click the Security tab, then click Advanced.
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%
" General I Sharing | Previous Versions I Customize I
Object name: C:‘Home_Folders

GI‘OLID ar User Names:

TICREATOR OWNER

82 SYSTEM

52, Administrators (FILR-LAB'Administrators)
82, Users (FILR-LABUsers)

To change pemissions, click Edit.

Pemissions for CREATOR
OWNER

Full cortrol

Modify

Read & execute

Ligt folder contents
Read

Wiite hd

Edit... |

Deny

-

Allow

For special permissions or advanced settings,
click Advanced.

Leam about access control and pemmissions

Close [Cance| | Apply |

1b Click Change Permissions.

l Advanced Security Settings for Home_Folders ﬂ

Pemmissions |A|.|diting | Owner | Effective Permissions |

To view details of a permission entry, double-click the entry. To modify permissions, click Change Pemissions.

Object name: C:\Home_Folders

Permizsion entries:

Name

Inherited From "oply To

28

SYSTEM

Allowe

Allow Administrators (FILR-LAB...
Allow Users (FILR-LAB\Users)
Allow Users (FILR-LABUsers)
Allow CREATOR OWNER

Change Pemissions. .. I

Managing permission entries

Pemission

Full control \
Full control Ch
Read & execute Ch
Special CH
Special CA

¥ Include inhertable pemissions fom this obiects parent

This f|:|||:|E=I', subfolders and...
This folder, subfolders and...
This folder, subfolders and...

Thig folder and subfolders
Subfolders and files only

o]

Cancel | Apply

1c Deselect Include inheritable permissions from this object’s parent, then on the warning, click

Add.
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X

Permissions |

To view or edit details for a permission entry, select the entry and then didk Edit.

x

Waming: f you proceed, inheritable parent pemissions will no longer
propagate to this object.

Object name: C:\Home

Permission entries: ! 4
A
Type | Name - —Uid{ Md to coqveﬂ_and add inherted parent permissions as explicit
permissions on this object.
Allow SYSTEM
Allow Administrators - Click. Remove to remove inherited parent permissions from this object.
Allow Users (FILR-L4
Allow Users (FILRA. - Click Cancel if you do not want to modify inhertance settings at this time.
Allow CREATOR. OW
Add I Remove Cancel

Add... Edit... | Remaye |

Indude inheritable permissions from this object's parent

[” Replace all child object permissions with inheritable permissions from this ohject

Manaain: rmission entries

oK Cancel | Appli |

1d In the Permission entries list, Shift-click to select the two Users entries, then click Remouve.

Permission enfries:

Type | Mame | Permission | Inherited From | Apply To |
Allow SYSTEM Full control <not inherited = This folder, subfolders a...
Allow Administrators (FILR4A...  Full control <not inherited = This folder, subfolders a...

(T 3l 3, . . . n . P -~

CREATOR OWMER Subfolders and files only

Add... | Edit: .. | Remove I

le Click Add.

Permission entries:
Type | Name | Permission | Inherited From | Apply To |
Allow SYSTEM Full control <not inherited = This folder, subfolders a...
Allow Administrators (FILR4A...  Full control <not inherited = This folder, subfolders a...
Allow CREATOR OWNER Special <not inherited = Subfolders and files only
Add... Edit... | Remaove |

1f Type filrproxyuser, then click Check Names.

Preparing Folders and Files 29



30

select User, Computer, Service Account, or Group

Select this object type:

IUser, Group, or Built4n security principal

From this location:

IFiIr-Iab.IocaI

Erter the object name to select (examples):

filrpropgyuser

FEE,

Ad\ranc:ed...l ok | cancel |

Cbject Types...

Locations...

Check Names

A
1g Click OK.
Select this object type:
IUser, Group, or Built4n security principal Cbject Types... |
From this location:
Iﬁlr—lab.local Locations... |
Enter the object name to select ([examplas):
Filr Prosoyuser filprosuser@filrdab local) Checlk Names |
Advanced. . | ok | Concel |
P
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1h Allow full control, then click OK > OK > OK > Close.

l Permission Entry for Home_Folders x|

Object |

Mame: I’roxyuser{ﬁlrproxyuser@ﬁlr—lab.lomrj Change... |

Apply to: IThis folder, subfolders and files j

Permissions:

Full control 1=
Traverse folder [ execute file
List folder [ read data

Read attributes

Read extended attributes
Create files [ write data
Create folders [ append data
Write attributes

Write extended attributes
Delete subfolders and files
Delete

-

r Apply these permissions to objects andjfor Clear All |

containers within this container only

|IEEEQEEEQEE|E
Io0ooooooooo|s

oK I Cancel |

2 Continue with Assigning Home Folders.

5.3 Assigning Home Folders

1 In Administrative Tools > Active Directory Users and Computers, right-click A Black, then select
Properties.
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B Actve Direcory Users and Computers K 0%

File Acton View Help

€z daXEd=Hmta 7%
i Active Directory Users and Comput | Mame | Type Description
|| Saved Queries m

_ Copy...

= -}F'j ﬁlr-lab.lc:cal 5 A Blue Add to a group. ..
= Builtin 5 A Gray Disable Account
(] Computers % aGreen  Resetpassword...

[2] Domain Contrallers 5 A Orang
[ ForeignSecurityPrincipals 5 A Pink Jel=
|| Managed Service Accounts 5 A Red SrElolo=als

= Send Mail
ﬂ Iis;..lssers ?_} A Yellow
?_} Fir proy Al Tasks b
l | Ml i
| l_ Delete
Rename
Properties
Help
2 Click the Profile tab.
Dialin I Environmert I Sessions I Remote control
 Remote Desktop Services Profile |  Personal Vitusl Desktop | COM«+
General I Address I Account | Telephon&sl Organization I Member Of
r~ User profile
Profile path: |
Logon script: I
~ Home folder
% Local path: I
" Connect: I j Ta: I

oK | Camcel | el | Hep |

3 Under Home folder, select Connect, then click the Connect drop-down list and select H:.
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Dialn I Environment I Sessions I Remote control
Remote Desktop Services Profile I Personal Vinual Desktop I COM+
General I Address I Accourt  Profile |Telephones I Organization I Member Of

 User profile
Profile path: |

Logon script: I

r Home folder
" Local path: I

{* Connect: z j Ta: I

Ef{ Cancel | Mooy | Hep |

mmo

4 For the first user, in the To field, type the UNC path to the HOME_Folders share on your
Windows server, followed by %username%.

For example, the share path on the Windows server used for the development of this guide is
\\Windows-DC\Home Folders$\%username$.

Home folder

" Local path: I

¥ Connect: IH: j To: I:lC'[-.chrne_FDIdersE-"-_T;usemameﬁ';

5 Select the string and copy it to the clipboard by using Ctrl+C.
For the second and subsequent users, you can use Ctrl+V to paste the string into the To field.
6 Click OK.
7 Repeat from Step 1 for each of the following users:
¢ ABlue
¢ ARed
¢ A Yellow

8 After configuring the home folders indicated, verify that the home folders have been created by
accessing the Home_Folders folder in Windows Explorer.
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5.4

54.1

=T
‘Gl\ Jv ~ Local ... ~ Home_... = - l‘illl Search Home_F... \!.]_"J

Organize * Indudeinlibrary *  Sharewith + 4= - E] l@l
B8 videos :I Name “ | Date modified | Type
J . ablack 7/15/2013 6:26 FM File folder
=L Computer , ablue 7/15/2013 6:26 PM File folder
£ . ared 7/15/20136:26PM  File folder
olders . ayellow 7/15/2013 6:27 FM File folder
J |netpub _I
o] <l | 2

9 Continue with Setting Up the Other Hands-on Exercise Folders and Files.

Setting Up the Other Hands-on Exercise Folders and Files

¢ Section 5.4.1, “Creating Shares and Changing Share Permissions,” on page 34

¢ Section 5.4.2, “Changing the NTFS Permissions,” on page 39

Creating Shares and Changing Share Permissions

Table 5-1 lists the rest of the Filr exercise folder names and the users to assign full share permissions.

Table 5-1 Share Permission Assignments

Folder Name Users to Assign Full Share Permissions

Dev * ared

+ filrproxyuser

IS + ablue
+ filrproxyuser
Mrktg + ayellow

+ filrproxyuser

Sales * ablack

+ filrproxyuser

Create shares and assign share access by doing the following for each folder listed.

1 In Windows Explorer, right-click one of the four folders in Table 5-1, starting with Dev, then click
Properties.
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. Filr Exercise Folders

=101 x|

‘@Ov| . = Local... ~Filr Exe... =

- m I Search Filr Exercise Fald. .. @‘

Organize * - Open Indudeinlibrary =  Sharewith ~ =» &= = E;l I@I
:I Mame ~ | Date modi
1M Computer
‘E_:: Local Disk (C:) @ Open m_l
. Filr Exercise FnIdJ 15 Qpen in new window 7/10/201:
) Mrk: 710201z
. ?—hme_FnIders Share with R 10/
| inetpub - Sale pestore previous versions 7/10/201%
. Perflogs Indude in library 3
| Proaram Files LI_I_4 LI
Send to *
Devy Date modified: 71
File folder Cut
Copy

Create shortout
Delete
Rename

Properties

2 Click the Sharing tab, then click Advanced Sharing.

n Dev Properties

" General | Semr'rtyl Previous Versions I Customize I

X

 Metworlk File and Folder Sharing
T Dev

ﬁ], Neot Shared

Metworl Path:

Mot Shared

 Advanced Sharing

advanced sharing options.

| @Mvanc&d Sharing... I

Set custom pemissions, create multiple shares, and set other

3 Select the Share this folder option, then click Permissions.
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Share this folder

~Settings

Share name;

I Dev

fdd | Remove |

Limit the number of simultaneous users to: 16777=
Comments:
Permissions Caching |

oK I Cancel | Apply

5I

QK Cancel Spply

4 Click Remove to remove access by the Everyone group.

N Permissions for Dev x|

Share Permissions |

GI’OLID Qr User Names:

|_

Add... | Remove |

5 Click Add.

Share Pemissions |

GI'CIIJD ar user names:

Mo groups or users have permission to access this object. ;I
However, the owner of this ohject can assign pemissions.
I

Add... Hemowve I

M rermissions for Dev
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6 In the Enter the object names to select field, type the users listed in the second column of Table 5-1
on page 34, separated by a semicolon.

For example, for the Dev folder, type ared; filrproxyuser, then click Check Names to validate
your entries.

Select Users, Computers, Service Accounts, or Groups

Select this object type:
IUsers. Groups, or Buitt-in securty principals Ohbject Types. ..

From this location:
Iﬁlr—lab.lncal Locations...

i

Enterthe object names to select (examples):

ared filrproognuser Check Mames

Advanced... | QK I Cancel

P
7 Click OK.
Select this object type:

Il._lsers. Groups, or Builtin security principals Object Types... |

From this location:

Iﬁlr—lab.local Locations... |

Enterthe object names to select (examples):
A Red {ared&ilrdab Jocal); Fir Proxyuser filproguser=irdab Jocal) Check Mames |

Advanced... | QK Cancel |

i

8 With Filr Proxyuser selected, under Permissions for Filr Proxyuser > Full Control, select Allow.
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X

Share Permissions |

GI’OLID Qr User Nnames:

2. A Red {ared@filrdab Jocal)
il Filr Proocyuser filrprosgyuser@ilr-ab local)

Add... | Remove |
Pemissions for Filr Prosyuser Alow Deny
Full Cortrol [ O
Change a
O

Read

Leam about access control and permissions

ok | Canced | sopy

9 Select the other user and assign it Full Control as well.

5I

Share Permissions |

GI’OIJD ar uUser Names:

2.|A Red fared@fiirfab Jocal)
3, Filr Proccyuser filmprosayuser@filrdab local)

Add | Remove |
Permissions for A Red Alow Deny
Full Control O
Change a
Fead a

Leam about access control and permissions

QK I Cancel Apply

10 Click OK > OK > Close.
11 Right-click the next folder (skipping Home_Folders), then repeat from Step 1 until all of the

folders have been shared and secured.
12 Continue with Changing the NTFS Permissions.
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5.4.2

Changing the NTFS Permissions

Table 5-2 lists the Filr exercise folder names and the users to assign full NTFS permissions.

Table 5-2 NTFS Permission Assignments

Folder Name

Users to Assign Full NTFS Permissions

Filr Exercise Folders

Dev ared

IS ablue
Mrktg ayellow
Sales ablack

filrproxyuser

Adjust NTFS permissions to the Filr_Exercise_Folders folder by doing the following:

1 In Windows Explorer, right-click Filr_Exercise_Folders and select Properties.

A& Local Disk (C)

=101 x|

O ) E -com. -toin..-

* (&3 I Search L...

l

Organize * - Open = 2 = [l @
=] Pictures 2l Name - | Date modifiec
B videos _

Open
"M Computer Jinet  Openin new window
"E_::, Local Disk (C:) [ Per’ share with 3
| FilrExercise-Folc , Prov Restore previous wersions
L 5
| Devy ' Pro Indude in library
| Home_Folders Jse Sendto *
LIS W
. Win Cut
. Mrktg .
1 eir. Copy
| Sales ;I 4|
_ _ Create shortout
' Filr-Exercise-Folders Delete
File folder Rename

Properties |

2 Click the Security tab, then click Advanced.
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E
"General I Sharing | Previous Versions I Customize I

Object name:  C:\Filr Exercize Folders

I:3I‘(.'IIJ|3| ar user names:

TACREATOR OWN

82 5YSTEM

2, Administrators (FILR-LAB\Administrators)
!??J Users (FILR-LAB"|sers)

To change pemissions, click Edit. Edit... |

Permizssions for CREATOR
OWNER Allow Deny

Full contral 1=
Modify

Read & execute

List folder contents

Read

Write hd

For special permissions or advanced settings,
click Advanced.

Leam about access control and permissions

ok | caned | oo |

3 Click Change Permissions.

l Advanced Security Settings for Filr Exercise Folders
Permissions |A|.|d'rting | Owner | Effective Pemissions |
To view details of a permission entry, double-click the entry. To modify permissions, click Change Permissions.
Object name: C:\Filr Exercise Folders

Pemission entries:

Type Name Permission Inherited From oply To
Alow SYSTEM Full contral CA

Allow Administrators (FILR-LAB... Full control
Allow Users (FILR-LAB"|sers) Read & execute
Allow Users (FILR-LAB"Users) Special

Allow CREATOR OWNER Special

This folder, subfolders and...
This folder, subfolders and...
This folder, subfolders and. ..
This folder and subfolders
Subfolders and files only

QoOon

Change Permissions... I

¥ [nclude inhertable pemissions fram this object's parent

Managing permission entries

ok | ceesl | bol

4 Deselect Include inheritable permissions from this object’s parent, then click Add.
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I Advanced Security Settings for Filr Exe x|
Permissions |
x

Lok = L FE 3 22 S0 AT Waming: if you proceed, inhertable parent permissions will no longer

propagate to this object.
Object name: C:'\Filr Exerc I i
T - Click Add to convert and add inherted parent pemissions as explicit

Permission entries: permigsions on this object.

Type | MName - Click Remowve to remove inherted parent pemissions from this object.

Allow SYSTEM

Allow Administrators (F: - Click Cancel if you do not want to modify inhertance settings at this time.

Allow Users (FILR-LABY

Allow Users (FILR-LABY i i Sienlic s

Allowy CREATOR. OWMEL = =y eI ST TE e T

Add... Edit... Remoye

Include inheritable permissions from this object's parent

[ Replace all child object permissions with inheritable permissions from this object

Managing permission entries

OK. Cancel Apply

5 In the Permission entries list, select the Users entries, then click Remouve.

l Advanced Security Settings for Filr Exercise Folders ﬂ

Permissions |

To view or edit details for & permission entry, select the entry and then dick Edit.

Object name: C:\Filr Exercise Folders

Permission entries:

Type | Mame | Permission | Inherited From | Apply To |
Allow SYSTEM Full contral <not inherited = This folder, subfolders a...

Allow Administrators (FILRLA...  Full control <not inherited = This folder, subfolders a...
) inherited

Spedial i i er and subfolders
Allow CREATOR OWNER. Spedal <not inherited = Subfolders and files only

Add... Edit. .. | Remave |

™ Indude inheritable permissions from this object’s parent

[ Replace all child object permissions with inheritable permissions from this object

Managing permission entries

oK I Cancel Apply

6 Click Add.
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. Advanced Security Settings for Filr Exercise Folders

Permissions |

To view or edit details for a permission entry, select the entry and then dick Edit.

Object name: C:'\Filr Exercise Folders

Permission entries:

Type Mame Permission Inherited From
SYSTEM Full control <not inherited =
Allow Administrators (FILR1A...  Full control <not inherited =
Allow CREATOR OWMER Special <not inherited =
Add... Edit... Remove

[™ Indude inheritable permissions from this object's parent

[ Replace all child object permissions with inheritable permissions from this object

Managing permission enfries

Apply To

This folder, subfolders a...
This folder, subfolders a...
Subfolders and files only

o]

Cancel Anply,

7 Type filrproxyuser, then click Check Names.

Select User, Computer, Service Account, or Group d |

Select this object type:
IUser, Group, or Builtin securty principal

Object Types...

From this location:
Iﬂlr—lab.local

Locations...

Enter the object name to select (examples):
filrproxyuser

Check Names

i3

Advanced... | oK I Cancel

8 Click OK.

Select User, Computer, Service Account, or Group

Select this object type:
IUser. Group, or Builtin securty principal

Object Types. ..

From this location:
Iﬂlr—lab.local

Locations...

Enter the object name to select (examples):
Filr P ser ffil

ilrab local Check Mames

P

Advanced... |
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9 Allow full control, then click OK > OK > OK > OK.

l Permission Entry for Filr Exercise Folders x|

-

Object |
Mame: I roxyuser (firproxyuser @filr-4ab.local) Change... |
Apply to: IThis folder, subfolders and files j
Permissions: Allow Deny
Full control o =
Traverse folder [ execute file a
List folder / read data O
Read attributes O
Read extended attributes a
Create files [ write data O
Create folders [ append data O
Write attributes a
Wirite extended attributes O =
Delete subfolders and files O
Delete O

r Apply these permissions to objects andfor Clear all |

containers within this container only

Managing permissions

oK I Cancel |

10 Double-click Filr-Exercise-Folders.

i
|@<_)v£ - Comp... - LlocalD... = » &3 | searchL...

Organize = o Open » ==~ [ @
= Pictures ﬂ Name = | Date modifiec ™
B videos

. Filr-Exerdse-Folders
M Computer J inetpub 7242013 1:
19_3 Local Disk (C:) | Perflogs 7/13/2009 9:
| FilrExercise-Folc . Program Files 7242013 1:
| Dev | Program Files (x86) 7/24/2013 1:
i Home_Folders | Users 7/24/2013 1;
) 15
Windows 7/24/2013 1:—
| Mrktg 124/

Fir-Exercise-Folders
File folder

1l Eilr EvarcicaEaldarean  2MEMN1T 20t
| Gales 'I 4| I »

11 Right-click the Dev folder listed in the right frame, then select Properties.
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12

Open
Open in new window

Share with 4
Restore previous versions
Indude in library 4

Send to 4

Cut
Copy

Create shortout
Delete
Rename

7/10/2013 9:34 AM

| Mrk: 7/10/2013 9:34 AM
. Sale 7/10/2013 9:34 AM

Click the Security tab, then click Edit.

General I Sharing M| Previous Versions I Customize I

Object name:  C:\Filr Bxercise Folders'Dev

IGI'()LID ar User names:

T1CREATOR OWNER

82 SYSTEM

;, Filr Proceyuser filproxyuser@filrdab local)
2, Admiristrators (FILR-LAB"Administrators)

To change pemissions, click Edit.

Pemmissions for CREATOR
OWNER Allow Derry

Full control 1=
Modify

Read & execute

List folder contents

Read pe
Write hd

For special pemmissions or advanced settings, Ad = |
click Advanced. e

Leam about access control and permissions

X

ok | caned | sp

13 Click Add.
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5I
Security |
Object name:  C:\Filr Exercise Folders’\Dev

GI’OIJD Qr User Names:

TV CREATOR OWNER

Q?J SYSTEM

3, Filr Proxyuser filrprosyuser@filrdab local)
82, Administrators (FILR-LAB\Administrators)

Add... I Remove |

Permissions for CREATOR
OWNER Allow

Full control a
Modify a
Fead & execute a
O
O

| »

List folder contents
Read

ooooo|s

Leam about access control and pemissions

ok | cance | iy |

14 Referring to Table 5-2 on page 39, type the user (object name) to assign full permissions to the
directory (ared is for Dev), then click Check Names.

Select Users, Computers, Service Accounts, or Groups

Select this object type:
IUsers, Groups, or Buitt4n securty principals Cbject Types...

From this location:
Iﬁlr—lab.local Locations...

Enter the object names to select (examples):
ared| Check Names

FiE,

Advanced... | 0K I Cancel

4
15 Click OK.
Select this object type:
IUsers. Groups, or Built-in securty principals Object Types. .

From this location:
Iﬁlr—lab.local Locations...

Erter the object names to select (eamples):
A Bed (ared&filrab Jocal Check Names

FEb

Advanced... | 0K i Cancel |
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16 Allow full control, then click OK > OK.

b rermssionsforpey T
Security |
Object name:  C:\Filr Exercise Folders‘\Dev

GI‘OLID ar User Nnames:

L A Red {ared@filr-ab local)

2 CREATOR OWNER

52 SYSTEM

;4, Filr Proogyuser filrproxguser@ilr-ab local)
2, Administrators (FILR-LABAdministrators)

Add... | Remove |
Permissions for A Red Alow Deny
Full control o =
Madify O
Read & exscute a
List folder contents O =
Read o .

Leam about access control and permissions

0K i Cancel | Apply |

17 Right-click the next folder name listed in Table 5-2 on page 39, click Properties, then repeat from
Step 12 on page 44 until full rights have been assigned as indicated in the table.

When all of the folders have been assigned, continue with Chapter 6, “Deploying and
Configuring the Filr Appliances,” on page 47.
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Deploying and Configuring the Filr
Appliances

¢ Section 6.1, “Small Deployment: Deploying and Configuring,” on page 47
¢ Section 6.2, “Large Deployment: Deploying and Configuring,” on page 52

6.1 Small Deployment: Deploying and Configuring

¢ Section 6.1.1, “Deploying Filr,” on page 47
¢ Section 6.1.2, “Configuring the Filr Appliance,” on page 51

6.1.1 Deploying Filr

IMPORTANT: The instructions in this section assume that Filr is being deployed on a VMware
server.

If you are deploying Filr on Hyper-V, follow the instructions in “Hyper-V Configuration” in the
Nowell Filr 1.0.1 Installation and Configuration Guide to the point that you power on the appliance. Then
resume these instructions at Step 5 on page 48.

If you are deploying Filr on Xen, follow the instructions in “Xen Configuration” in the Novell Filr 1.0.1
Installation and Configuration Guide to the point that you power on the appliance. Then resume these
instructions at Step 5 on page 48.

1 On a workstation with the vSphere client installed, extract the Filr.x86_ 64-version.ovf.zip
file that you downloaded in Chapter 3, “Downloading Filr Software,” on page 13 until you have
a folder containing three files with .mf, .ovf, and .vimmdk extensions.

Mame

| Filrx86_64-version.mf
£ Filr.x86_64-version.ovf
% Filrxd86_64-version-diskl.wmdk

2 Using the vSphere client, attach to your VMware ESX server, then click File > Deploy OVF
Template.
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(&) 192.168.1.50 - vSphere Client

File | Edit View Inventory Adminis]

Mew »

Deploy OVF Template...
Export

Pomnst 1S

-

3 Browse to and open the Filr .ovf file, then proceed through the various dialogs as you normally
would until the virtual machine is deployed.

(&) 3% Deploying Novell Filr = 23

Deploying Movell Fir

Deploying disk 1 of 1 from C:\Filr
VMs"Filr-0.0.459Filr 86 _64-0.0.459-disk 1. vmdk

l Cancel

2 minutes and 39 seconds remaining

4 Edit the virtual machine settings and add a 100 GB hard disk.

Capadity
Disk Size: G v
Disk Provisioning

[~ Allocate and commit space on demand (Thin Provisioning)

[ Suppert dustering features such as Fault Tolerance

Location
+ Store with the virtual machine

" Specify a datastore:

= Back | Mext = I Cancel |

5 After the hard disk has been added, click Power on the virtual machine.
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e Bl e Summary | Resource Allocation | Performance | Event|

What is a Virtual Machine?

A virtual machine is a software computer that, like a
physical computer, runs an operating system and
applications. An operating system installed on a virtual
machine is called a guest operating system.

Because every virtual machine is an isolated computing
environment, you can use virtual machines as deskiop or
workstation environments, as testing environments, or to
consolidate server applications.

Virtual machines run on hosts. The same host can run
many virtual machines.

Basic Tasks

|b Power on the virtual machine

£ Edit virtual machine settings

6 After the appliance starts, accept the license agreement.

2. Novell Filr Appliance License

| Englsn |

manner prohibited by the United States Expart
applicable export laws, restrictions of regulations.

21, You have the rights expressly set forth
other. All rights in and to the Font Softwar
r‘ig‘.hiﬁ, are reserved under the copyright |a
and other jurisdictions. All rights resenve
going, to TJ'|! extent that any lan statut

Accept
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7 Complete the initial configuration settings, substituting the IP address and other settings that
you identified in Chapter 2, “Hands-on System Requirements,” on page 9 for the Filr appliance
on your network.

IMPORTANT: Ensure that the Time Zone settings match the settings of your Windows
environment.

For example, the following screen shows the IP addresses and the other information that was
used for the Filr appliance that was deployed in a private network when this guide was

developed.
Reot Passward Confirm Rooat Password:

novellfilr novellfilr l
Waadmin Passwerd: Confirm Vaadmin Passwerd:

novellfilr novellfilr l

Hestname je.g. serverdemain.com):

filrfilr-lab. local ]

IP Address je.g. 10.0.0.1):

92.168.1.110 l

Netwoik Mask (e.g. 255.255.255.0):

EE 255 255 0 |

[[n]
W (%)
o
L]
5
[T
-
™
o
~
=)
o
=]
qa

]
ONS Serverje.g. 10.0.0.3): Alternate DNS Semver (e.g. 10.0.0.3):
2769 20 ) 1
NTP Server's (e.g. time.domain.com):

Region: Time Zone:

| Fhd l |[ Meuntain (Denver) - l|

8 Proceed through the screens, accepting the defaults, until the configuration process completes.

The system iz ready for appliance configuration.
To configure the appliance:
1. At your management workstation, open a browser and enter one of the following URLs:

https:r - filr.filr-lab.local :9443
https:--192.168.1.110:9443

. Log in as vaadmin with the password that you set.

IMPORTANT: Do not use the terminal prompt before consulting the documentation.
Appliance administration requires appliance-specific tools.
Using standard tools can result in service disruption or failure.

filr login: _

9 Continue with Configuring the Filr Appliance.
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6.1.2 Configuring the Filr Appliance

1 In your management browser, enter the following URL: https://Filr-appliance-IP-
address:9443.

2 Click through the security warnings and accept the certificate if needed.

3 Log in with Username: vaadmin and the password you set in Step 7 on page 55.

Novells
Novell Filr Appliance

Username

i rd

4 Click the Novell Appliance Configuration icon.

i

5 Ensure that Small Deployment is selected, then click Next.

@ Small Deployment
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6 Specify and confirm NOv3llfilr as the root password.

User Name: root

User Password: | NOv3Hifilr

Confirm Password: | NOv3Iifilr

8 Skip to Chapter 7, “Securing LDAP Communications between Filr and Active Directory,” on
page 69.

6.2 Large Deployment: Deploying and Configuring

¢ Section 6.2.1, “Deploying Filr,” on page 53

¢ Section 6.2.2, “Deploying Search,” on page 56

¢ Section 6.2.3, “Deploying MySQL,” on page 58

¢ Section 6.2.4, “Configuring the MySQL Appliance,” on page 60
¢ Section 6.2.5, “Configuring the Search Appliance,” on page 63
¢ Section 6.2.6, “Configuring the Filr Appliance,” on page 65

IMPORTANT: The instructions in this section assume that the Filr appliances are being deployed on
a VMware server.

If you are deploying Filr on Hyper-V or Xen, refer to the instructions in “Installing the Filr Appliance
and Configuring the Operating System” in the Novell Filr 1.0.1 Installation and Configuration Guide. In
each case, after you reach the point where you accept the license agreement, you can return to the
respective deploying sections in this guide and continue on from that point.
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6.2.1

Deploying Filr

1 On a workstation with the vSphere client installed, extract the Filr.x86_ 64-version.ovf.zip
file that you downloaded in Chapter 3, “Downloading Filr Software,” on page 13 until you have
a folder containing three files with .mf, .ovf, and .vimdk extensions.

Mame

| Filrx86_64-version.mf
L4 Filr.xB6_64-version.ovf

% Filr.x86_64-version-diskl.vmdk

2 Using the vSphere client, attach to your VMware ESX server, then click File > Deploy OVE

Template.

(&) 192.168.1.50 - vSphere Client

File | Edit View Inventory Adminis]

Mew

Deploy OVF Template...
Export

Bomort

3

-

3 Browse to and open the Filr.x86 version.ovf.zip file, then proceed through the various
dialogs as you normally would until the virtual machine is deployed.

@ 3% Deploying Movell Filr

= P

Deploying Movell Fir

Deploying disk 1 of 1 from C:\Filr

2 minutes and 39 seconds remaining

WMs"Filr-0.0.4559"Filr x86_64-0.0.455-disk 1.vmdk

Cancel

4 Edit the virtual machine settings and add a 100 GB hard disk.

Capadty

Disk Size: G v

Disk Provisioning

Location
(% Store with the virtual machine

" Specify a datastore:

[~ Allocate and commit space on demand (Thin Provisioning)

[ Support dustering features such as Fault Tolerance

= Back

| Mext = I Cancel |

Deploying and Configuring the Filr Appliances

53



TIP: When you deploy Filr in a production environment, you have a choice to make at this point.
You can either add a second hard disk to the appliance or you can specify an NFS mount point
for shared storage.

Shared storage lets you provide a more robust and expandable environment by clustering
multiple Filr appliances that all access the same storage area. For more information, see the
information in the Novell Filr 1.0.1 Installation and Configuration Guide, starting with the table
named “Filr Appliance Storage.”

5 After the hard disk has been added, click Power on the virtual machine.

el Bl el Summary | Resource Allocation | Performance | Even

What is a Virtual Machine?

A virtual machine is a software computer that, like a
physical computer, runs an operating system and
applications. An operating system installed on a virtual
machine is called a guest operating system.

Because every virtual machine is an isolated computing
environment, you can use virtual machines as desktop or
workstation environments, as testing environments, or fo
consolidate server applications.

Virtual machines run on hosts. The same host can run
many virtual machines.

Basic Tasks

||> Power on the virtual machine

£ Edit virtual machine settings

6 After the appliance starts, accept the license agreement.
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@ Novell Filr Appliance Licens

[Engiish

manner prohibited by the United El_’at;! par
applicable exporn laws, r!ﬂrininnsnr'm;ﬂlaﬁﬁ

21, You have the rights expressly set forth in-
other, &ll fights in and te the Font Slufﬁua'r!, i

rights, are reserved under the copyright laws o
a tt:h_!r.juris_di:ti:ns..ﬂll ri'ghfﬁ'[mf\r!ﬂ__.

Accept

7 Complete the initial configuration settings, substituting the IP address and other settings that
you identified in Chapter 2, “Hands-on System Requirements,” on page 9 for the Filr appliance
on your network.

IMPORTANT: Ensure that the Time Zone settings match the settings of your Windows
environment.

For example, the following screen shows the IP addresses and the other information that was
used for the Filr appliance that was deployed in a private network when this guide was
developed.
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Root Passwerd: Confirm Rooat Password:
novellfilr novellfilr l
admin Pasavord: Confirm Vaadmin Passvord:

[navelfilr| |

Hestname je.g. serverdemain.com):

s

filrfilr-lab.local l

1P Address je.g. 10.0.0.1):

- |
Network Mask (e.g. 255.255 255.0):
l
Gateway (e.g. 10.0.0.2):

l
DNS Server (e.g. 10.0.0.3): Alternate DNS Server (e.g. 10.0.0.3):
[isz1501200) ) 1
NTP Server's (e.g. time.domain.com):

Region: Time Zone:

[usAl i ] |[Mountain {Denver) - ]|

8 Proceed through the screens, accepting the defaults, until the configuration process completes.

The =ystem is ready for appliance configuration.

To configure the appliance:
1. At your management workstation, open a browser and enter one of the following URLs:

https:s-filr.filr-lab.local:9443
https:--192.168.1.110:9443

. Log in as vaadmin with the password that you set.

IMPORTANT: Do not use the terminal prompt before consulting the documentation.
Appliance administration requires appliance-specific tools.
Using standard tools can result in service disruption or failure.

filr login: _

9 Continue with Deploying Search.

6.2.2 Deploying Search

1 On the VMware workstation host machine, extract the Filrsearch.x86 64-version.ovf.zip
file that you downloaded in Downloading Filr Software until you have a folder containing three
files with .mf, .ovf, and .vimdk extensions.

MName -

|| Filrsearchx86_64-version.mf
£ Filrsearch x86_64-version.ovf
% Filrsearch x86_64-version-diskl vmdk
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2 Proceed as you did with Filr by deploying the Filrsearch OVF template file, and so on until the
virtual machine is deployed.

(%) 38% Deploying Filrsearch = 23

Deploying Filrsearch x86_64-0.0.2%6

Deploying disk 1 of 1 from C:\Filr
WMs'Filrsearch-0.0.296\Filrsearch x86_64-0.0.296-disk 1.vmdk

INNEENEN Cancd

53 seconds remaining

o

3 Edit the virtual machine settings and add a 25 GB disk.

Capadity
Disk Size: G v
Disk Provisioning

[~ Allocate and commit space on demand (Thin Provisioning)

[~ Suppert dustering features such as Fault Tolerance

Location
+ Store with the virtual machine

(" Specify a datastore:

| _Browee. |
= Badk | Mext = I Cancel |

4 After the hard disk has been added, power on the virtual machine.

5 When the license agreement appears, read and accept it, then complete the initial configuration
settings, as shown below. Substitute the IP address and other settings that you identified in
Chapter 2, “Hands-on System Requirements,” on page 9 for the Filrsearch appliance on your
network.

IMPORTANT: Ensure that the Time Zone settings match the settings of the Windows
environment.

For example, the following screen shows the IP addresses and the other information that was
used for the Filrsearch appliance that was deployed in a private network when this guide was
developed.
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Root P assword: Confirm Roct Password:

Waadmin Password: Confirrm Vaadmin Password:
]
Hostname (2.g. server.domain. corm):

firsearch.filr-lab. local ]

IP Address (e.g. 10.0.0.1):

1521681111 ]

Metwerk Mask [e.g. 255.255.255.0):

255.255.255.0 ]

Gateway (e.g. 10.0.0.2):

192-._15._1. 1 ]

]

DMS Server (e.g. 10.0.0.2): Alernate DNS Server (e.g. 10.0.0.3):

[ 192 188.1.200 ]

MIP Server/s (2.g. time.domain.cam):

[ time-a.nist. gow ]

Begion: Tirme Zone:

[USA - l ‘[ Mountain [Denver) - ”

6 Proceed through the screens, accepting the defaults, until the configuration process completes.

The system is ready for appliance configuration.

To configure the appliance:
1. At your management workstation, open a browser and enter one of the following URLs:

https:s-filrsearch.filr-lab.local :9443
https:--192.168.1.111:9443

. Log in as vaadmin with the passuword that you set.

IMPORTANT: Do not use the terminal prompt before consulting the documentat
fAppliance administration requires appliance-specific tools.
Using standard tools can result in service disruption or failure.

filrsearch login:

7 Continue with Deploying MySQL.

6.2.3 Deploying MySQL

1 On the VMware workstation host machine, extract the MySQL.x86 64-version.ovf.zip file
that you downloaded in Downloading Filr Software until you have a folder containing three
files with .mf, .ovf, and .vimdk extensions.

Mame

| MySQLxB6_84-version.mf

£ MySQL.xB6_64-version.ovf
% MySQL.x86_64-version-diskl wmdk
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2 Proceed as you did with Filr and Filrsearch by deploying the MySQL OVF template file, and so
on until the virtual machine is deployed.

54% Deploying MySGQL =] 8
ploying My

Deploying MySQL

Deploying disk 1 of 1 from C:\Filr
VMs \MySQL-0.0.188"\MySGL xB6_64-0.0.188-disk 1.vmdk

L] Cancel

37 seconds remaining

3 Edit the virtual machine settings and add a 100 GB disk.

Capacity

Disk Size: | g ~|

Disk Provisioning

[ Allocate and commit space on demand {Thin Provisioning)

[ Support dustering features such as Fault Tolerance

Location
* Store with the virtual machine

(" spedfy a datastore:

| _Browee.. |
< Back | Mext = I Cancel |

4 After the hard disk has been added, power on the virtual machine.

4

5 When the license appears, read and accept it, then complete the initial configuration settings as
shown below. Substitute the IP address and other network settings that you identified in
Chapter 2, “Hands-on System Requirements,” on page 9 for the MySQL appliance.

IMPORTANT: Ensure that the Time Zone settings match the settings of the Windows server.
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Root Password: Conrfirrn Root P assword:

novellfilr novellfilr ]
Waadmin P assword: Confirm Vaadmin Password:
navellfilr novellfilr ]

Hostname (e.g. server.demain.com):

rrysglfilr-lab. local ]

IF Address (e.g. 10.0.0.1):

1521681112 ]

Metweork Mask (e.g. 255.255.255.0):

253.253.255.0 ]

Gateway (e.g. 10.0.0.2):

152168.1.1 |

]

DMS Server (e.g. 10.0.0.3): Alernate DMS Server (e.g. 10.0.0.3):
[ 192.168.1.200 ] [

MIP Server/s (2.g. time. domain. corm):

[time—a.nist.gou ]

Region: Tirne Zone:

[USA - ] [MountainiDenverJ v ]

6 Proceed through the screens, accepting the defaults, until the configuration process completes.
The system is ready for appliance configuratiom.

To configure the appliance:
1. At your management workstation, open a browser and enter one of the following URLs:

https:rsmysql.filr-lab.local :9443
https:--192.168.1.112:9443

. Log in as vaadmin with the passuord that you set.

IMPORTANT: Do not use the terminal prompt before consulting the documentation.
fippliance administration requires appliance-specific tools.
Using standard tools can result in service disruption or failure.

mysql login:

7 Continue with Configuring the MySQL Appliance.

6.24  Configuring the MySQL Appliance

1 Launch your management browser on the management workstation and enter the following
URL: https://MySQL-appliance-ip-address: 9443.

2 Click through the security warnings and accept the certificate if needed.

3 Log in with Username: vaadmin and the password you set for the vaadmin user in Step 5 on
page 59.
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Ll

Novell:

{User

me

ord

4 Click the phpMyAdmin icon.

phpM yAr

5 Type Username root and Password root, then click Go.

Log in @
Username:
root
Password:
root

6 Click Users.

I';ﬁ localhost

i Databases =[] SQL (5, Status [& Ex

7 Create a database user for the Filr appliance by doing the following:
7a Click Add User.
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& Add user

7b Type the required information in the fields indicated.

Field Name Value to Type

User name filr

Host ip_address_of_Filr_appliance
Password password

Re-type password

7c Select Create database with same name and grant all privileges, then click Add User.

Add user

Host:
Passwaord:
Re-type:

Generate
password:

Mone

User name:

Login Information

Use text field: E

Use text field: E |fp_address_of_Ffb’_appiiancE @

Use text field: E

Database for user

[@ Create database with same name and grant all privileges |

Grant all privileges on wildcard name (username'_%)

Add user Cancel

8 Secure the MySQL appliance by changing the root user password.

8a In the Users Overview section, select root, then click Edit Privileges.
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Users overview

User Host Password Global privileges &)
O Any % USAEE
[ Any  localhost No USAGE
[ Any  mysgl Mo USAGE

=1 Ailr 192.168.1.110 Yes
[[] ganglia localhost Yes

root % Yes

[ root  127.0.01 Mao
[ root localhost Yes

[ root  mysgl Ma

8b Scroll down to the Change password section, type a new password in both Password fields,

then click Go.

USACE

ALL PRIVILEGES

ALL PRIVILEGES

ALL PRIVILEGES

ALL PRIVILEGES

ALL PRIVILEGES

Grant
Mo

Mo

Mo

Mo

Mo
Yes

Action

£ Edit Privileges |2 Export
£ Edit Privileges [& Export
£ Edit Privileges [ Export
£y Edit Privileges &2 Export
£ Edit Privileges |2 Export
& [t Piegee] s ooon
£ Edit Privileges |52l Export
£ Edit Privileges [&E Export
£ Edit Privileges |2 Export

Change password

*) No Password

@ Password:
-

Password Hashing: @ MySQL 4.1+

Re-type:

© MySQL 4.0 compatible

Generate password

password

Go

9 Continue with Configuring the Search Appliance.

6.2.5 Configuring the Search Appliance

1 In your management browser, enter the following URL: https://Filrsearch-appliance-ip-

address:9443.

2 Click through the security warnings and accept the certificate if needed.

3 Log in with Username: vaadmin and the password you set for the vaadmin user in Step 6 on

page 58.
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L)

Novell:

Usemn

4 Click the Filr Search Appliance Configuration icon.

2

i

5 Click Next.

Filr Search Configuration Wizard *

Is this a new appliance, or are you upgrading from an existing one?

@ New

| MNext |

6 Type and confirm a Password for the search service, then click Finish.
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Filr Search Configuration Wizard o

Supply a password for the default lucene service user:

Password:
Re-type Password:

7 Click Submit.

TDe=

8 When the password is updated, continue with Configuring the Filr Appliance.

6.2.6  Configuring the Filr Appliance

1 In your management browser, enter the following URL: https://Filr-appliance-IP-
address:9443.

2 Click through the security warnings and accept the certificate if needed.

3 Log in with Username: vaadmin and the password you set in Step 7 on page 55.

L)

Novells
Novell Filr Appliance

Username

vaadmin

Pz ord

password

4 Click the Novell Appliance Configuration icon.
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5 Ensure that Large Deployment is selected, then click Next.

Filr Configuration Wizard

Pick an option.

) Small Deployment

Set up an evaluation environment or simall nefwork infrastructure.
The Lucene search service and MySGQL database will be installed on this Filr virtual
appliance

Large Deployment

Set up a scalable infrastructure.
The Lucene search server and MySQL database will run separately.

The Filr Appliance is not configured with "Shared Storage™ which is required for
clustering of Filr. If you wish for this appliance to be part of a cluster you must
redeploy and create "Shared Storage” in the initial install.

6 Type the IP address of the MySQL appliance in the Host Name field, and the User Password that
you specified in Step 7b on page 62, then click Next.

Specify the access information (how to connect) for the MySQL database

Database Type: My3QL
Host Mame: |My5QL—applfance—fp—address|
Pot | 3306 53

Database Mame:  filr

UserMame:  filr

User Password:  |possword

The MySQL database can be:

- The integrated database running in the Fir virtual appliance (localhost)

- The MySQL virtual appliance that is included with Filr, running separately.

- A MySQL database server running in a virtual or physical machine on your network

7 Type the IP address of the Filrsearch appliance in the Host Name field, and the Lucene User
Password that you specified in Step 6 on page 64, then click Next.
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Search Appliance

Specify the access information for the Search Appliance Server

Host MName: |Fﬂrseard:-appi£ance-:}u-address|

RMiPort 1199 &5 (Defaultis 1199)

Lucene User Name: lucene service

Lucene User Password:

The Lucene search server can be:
- The integrated search server in the Filr virtual appliance (locai)
-The Lucene virtual appliance that is included with Filr, running separately.

Previous

8 Click Finish.

Default Locale

Select the primary language of the Filr server.

Default Locale: English (United States) -

O (D)

You now have a basic large deployment Filr infrastructure.

Continue with Chapter 7, “Securing LDAP Communications between Filr and Active Directory,” on

page 69.
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Securing LDAP Communications
between Filr and Active Directory

1 Generate a self-signed certificate for Active Directory.

la On the Windows server, click Start > Run, then enter mmc.

CIEEE— x|

= Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you.

Open: Immc j

5l This task will be created with administrative privileges.

| 0K I Cancel Browse... |

1b In MMC, type Ctrl+M.

1c If the Internet Information Services (IIS) Manager snap-in is not installed on your Windows
server, install it.

1d With IIS selected, click Add, then click OK.

i
You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:
Snap-in | Vendor |:| [] console Root Edit Extensions... |
| Folder Microsoft Car... _" Internet Information Services (

_iGroup Policy Manag... Microsoft Cor... Bz |

_: Group Policy Manag... Microsoft Cor...
_: Group Policy Object ... Microsoft Cor... Mave LUp |

[ Group Policy Starter ... Microsoft Cor...
Microsoft Cor... Mawe Down |

‘o IP Security Monitor Microsoft Cor...

@ IP Security Policy Ma... Microsoft Cor...

~|Remote Desktop Ser... Microsoft Cor...
SRemote Deskton Ses... Microsaft Cor... LI 4] | _'I Slmi |
Ok | Cancel |

le In the left frame, click Internet Information Services, then click a Windows server that Filr can
connect to for synchronizing the test users that you created in Chapter 4, “Creating Test
Users,” on page 17.
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] Console Root _— =
@ | & &) | > vmoon
- il |8

-5 Start Page
eS| WINDOWS-DC (FILR-LAE

1| | e |

1f In the Filter list, scroll down to Server Certificates and double-click the icon.

Filter: - =
== =l
QOutput Reguest
Caching Filtering

«Xy
Server Worker
Certificates Processes

|

1g In the Actions list, click Create Self-Signed Certificate.

Impaort...

Create Certificate Request...
Complete Certificate Request...

Create Domain Certificate. ..

| Create Self-Signed Certificate. .. |

1h Name the certificate with a name you can remember, such as the server name, then click

OK.

' Specify Friendly Name
)

2%

Specify a file name for the certificate request. This information can be sent to a certificate authority
for signing:

Specify a friendly name for the certificate:

|windows-dc

o 1

Cancel

1i Type Ctrl+M, select the Certificates plug-in, then click Add.
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Available snap-ins:

Snap-in | Vendor | -
%Acﬁve Directory Do...  Microsoft Cor...
ﬁﬁ.ﬁ.cﬁve Directory Site... Microsoft Cor. ..
: Active Directory Use... Microsoft Cor...

= | ActiveX Control Microsoft Cor... —

2 ADSI Edit Microsaft Cor...

E Authorization Manager Microsoft Caor...
Microsoft Caor...

,% DNS Microsoft Cor...

{3 Event Viewer Microsoft Caor... LI

1j Select Computer account, then click Next.

Certificates snap-in x|

This snap-4n will always manage certificates for:

™ My user account

" Service account

{* Computer account

< Back Next = Cancel

1k Click Finish.

Select Computer x|

Select the computer you want this snap-n to manage.

Thiz snap4n will always manage:

¥ Local computer: fthe computer this console is running on)

™ Another computer: I Browse... |

[~ Allow the selected computerto be changed when launching from the command line. This

only applies if you save the console.
<Back [ Fnsh | Cancel |

1l In the Snap-ins dialog, click OK.
1m In MMC, expand the Certificates plug-in, expand Personal, then click Certificates.
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F= Consolel - [Console Root\Certificates {Local Computer) 10| =]

ﬁ File  Action View Favorites Window Help |;[i|i|
NG EEIEEN

| Console Root Issued To = I Actions
Wl Internet Inf‘ormaho ‘T lwindows-DC. filrab.local Certificates
=] Eﬁl Certificates (Local ¢
| Personal More Actions »
Bl Certificates
| Trusted Root C1
| Enterprise Trus'
| Intermediate Ct
| Trusted Publishe
| Untrusted Certi
| Third-Party Roc

1 Trusted Peonle
Y _»|‘| | 0

|Persona| store contains 1 certificate. | |

]

HEHEEEHE

In Right-click the certificate you created, select All Tasks, then click Export....

= Consolel - [Console Root\Certificates (Local Computer) -0l x|
& Fle Acton View Favorites Window Help | 1= x|
&= | Hm |¥m|xmﬁ|ﬂ
7] Console Root Issued To = | Actions
W) Internet Inf‘ormaho
El G Certificates {Local € gEET
U= [ Personal b Open
|| certificates e
7] Trusted Root Ci Cut Request Certificate with New Key...
[ 7| Enterprise Trus: Copy Renew Certificate with New Key...
] Intermediate Ct Delete " Brivate Ke
[ Trusted Publish —| cEsEfImEdSEEs
[ Untrusted Cert Properties Advanced Operations 3
_| Third-Party Roc Help —
1 Trusted Peonle
_I_I | ]
|Con13|r'|s actions that can be performed on the item. | |

1o Inthe Certificate Export wizard, click Next.

Certificate Export Wizard |

Welcome to the Certificate Export
Wizard

P This wizard helps you copy certificates, certificate trust
" lists and certificate revocation lists from a certificate
- store to your disk.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept,

To continue, dick Mext.

< Back I Mext > i Cancel

1p Ensure that No, do not export the private key is selected, then click Next.

72 Filr 1.0.1 Hands-on Guide for Windows



Certificate Export Wizard x|
Export Private Key
‘You can choose to export the private key with the certificate.
Private keys are password protected. If you want to export the private key with the
certificate, you must type a password on a later page.
Do you want to export the private key with the certificate?
" Yes, export the private key
' No, do not export the private key
< Back I Next = i Cancel
1q Ensure that DER encoded binary is selected, then click Next.
Certificate Export Wizard x|
Export File Format
Certificates can be exported in a variety of file formats.
Select the format you want to use:
|f:' DER encoded binary %.509 {.CER}|
{~ Base-64 encoded ¥.509 (.CER)
™ Cryptographic Message Syntax Standard - PKCS #7 Certificates (.P7E)
™| Include all certificates in the certification path)if possible
< Back I Mext = I Cancel
1r Name the certificate, then click Next.
Certificate Export Wizard x|

File to Export
Specify the name of the file you want to export

File name:

I windows-dc-cert Browse... |

< Back I Mext = I Cancel

1s Click Finish > OK.
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Certificate Export Wizard |

Completing the Certificate Export
Wizard

You have successfully completed the Certificate Export

Ll =

E.-_:;:]?I You have specified the following settings:
Export Keys Mo
Indude all certificates in the certification path Mo
File Format DER. En
Kl | 2

< Back I Finish I Cancel |

The certificate is saved in C:\Users\ Your-User-Name.
1t Ensure that the certificate is accessible from your management browser.
2 Using your management browser, import the certificate into the Filr appliance’s Java Keystore:
2a In the upper-right corner of the Filr Console, click the Home link.
2b Click the Appliance System Configuration icon.

2c Click the Digital Certificates icon.

L=

MGITAL CERTIFICATES

2d Click File > Import > Trusted Certificate.
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Certificates in the Selected Key Store
Key Store:| JVM Certificates » Manages cert]
Edit = Reload
Mew Certificate (Key Pair) ‘ Cwner
[t |
Key Pair
Certification Request 3 |

2e Browse to the certificate file that you saved in Step 1s on page 73, then click Open.

150 Image kile
1.29GB

hs-2007-41-a-1280_wallpaper.jpg
JPEG image

689 KB
TortoiseSVM-1.7.12.24070-x04-swn-
1.79.msi

Windows Installer Package

B Win2008Key. bt
Text Document
29 bytes

windows-dc-cert.cer
ﬂ Security Certificate

762 bytes -
ame: windows-dc-cert.cer - [AII Files (*.*) VI
’ Open |v] ’ Cancel ]
2f Click OK.
Import Trusted Certificate ®
Certificate File: windows-dc-cert.cer Browse...
Alias: windows-dc-cert

2g Click Close.

[ Close ]

2h Click Reboot > OK > OK.

“ Reboot ]|

’ Shutdown ]
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As soon as the Filr appliance restarts, both the Windows server and Filr are prepared for the exercises
in Chapter 8, “Administering Filr,” on page 77.
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8.1

Administering Filr

The Filr administration exercises are summarized in the following graphic.

4 )

Windows Server Filr
Virtual Machine ¢ Virtual Appliance

| |
e— Sychronize AD Users s——— —% AD USErS i' Filr Users smp-

J . i
® — Ml Home Folders —— W My Files—— ‘iJ

9— Set Up Personal Storage

(@— Set Up Net Folders ——— I — ‘ Share Name ————o. ] NetFolder —p. '

Q— Set Up Sharing ‘L Shared with Me == ‘:\“‘?’,,,‘,‘Shared by Me =»

J

NOTE: If you want the ability to repeat the exercises that follow, consider taking a snapshot of the
Filr VMs before you begin. That way you can always restore the VMs to their original states without
risking ripple effects from previous steps.

This section guides you through the following tasks:

¢ Section 8.1, “Synchronizing LDAP Users,” on page 77

¢ Section 8.2, “Setting Up Users” My Files Folders,” on page 83

¢ Section 8.3, “Setting Up Net Folders,” on page 84

¢ Section 8.4, “Enabling Sharing,” on page 93

¢ Section 8.5, “Setting Guest Access,” on page 94

¢ Section 8.6, “Allowing the Desktop Application to Be Deployed,” on page 95

¢ Section 8.7, “(Optional) Setting Up Email Communication with the Filr VM,” on page 96

Synchronizing LDAP Users

In Section 4, “Creating Test Users,” on page 17, you populated Active Directory with the users shown
in Figure 8-1 on page 78.

Administering Filr 77



Figure 8-1 Users Created for the Filr Exercises

Name Type = Description |
3_‘; A Black User
3_‘; A& Blue User
3_; A Gray User
3_‘; A Green User
3_; A Orange User
3_‘; A Pink User
3_; A Red User
3_‘; A Yellow User
3_; Filr Proxyuser  User

Importing users to Filr is accomplished by setting up LDAP synchronization with Active Directory.
1 Using your administrative browser, access Filr through the following URL:

https://Filr-appliance-IP-address:8443
2 If prompted, accept and trust the certificate.

3 Sign in as User ID: admin with Password: admin.

Novell. Filr

[0 sign in using OpeniD

User ID: | [admin] |
Password: | ‘

SignIn

4 When prompted, change the password to the administrative password you have chosen.

You are currently using the default password. For security
reasons, you should change your password.

Current password:

| |

New password:

| Now3Ifil ‘

Confirm new password:

| |

| o L Cancel

5 Click admin (upper right), then select Administration Console.
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admin

admin

2 Administration Console

View Profile
Personal Preferences

Help

Sign out

6 Under System, click LDAP.

=2 .7 _ System

Desktop Application
Email

7 Click Add a New LDAP Source

Configure LDAP Synchronization

Add a New LDAP Source

8 Click OK.

This action is intended to add an LDAP directory as a source for synchronizing user information into
Filr.

This new LDAP source should not be used as a failover support for an LDAP directory you have
already specified.

9 Enter the LDAP source information.
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Field Name Value to Enter

LDAP Server URL ldaps://windows-server-IP-address

User DN IMPORTANT: This is the distinguished name of an Active Directory user
who has sufficient rights to access the information for the test users that
you created in Chapter 4, “Creating Test Users,” on page 17. For example,
it could be the user name that you used for that task.

TIP: If you aren’t certain of the syntax, open a terminal prompt on the
server and enter the dsquery user command.

For example, the DN for the Administrator user account used to create the
test users when developing this guide is:
cn=Administrator, cn=users,dc=£filr-lab,dc=1ocal.

Password The password of the user above.

For example, the password of the Administrator user on the server used
for this guide is NOv311fi!r.

LDAP Unique Identifier objectGUID

LDAP Attribute for Filr sAMAccountName

Configure LDAP Synchreonization

ldaps:/192.168.1.200

D €
Configuration for: Idaps:/1192.168.1.200

The LDAP server URL format is Idap://host:port  For example: Idap://localhost: 389
LDAP server URL |ldaps:192.168.1.200

User DN [cn=Administrator,cn=Users,dc=filr-lab,dc=local|

Password MOw3IIfilr

For eDirectory, use GUID. For Active Directory, use objectGUID.

LDAP attribute that uniguely identifies a user or group:  |objectGUID
Users

LDAP attribute used for Filrname: | [sAMAccountMame

10 Skip to the Base DN field, then type the DN of the testusers container on your server.

For example, ou=testusers,dc=filr-lab,dc=1local.

Base DM [ou=testusers.dc=filr-lab.dc=local] ‘

This is the location of the users that you created in Active Directory (Figure 8-1 on page 78). As
with Step 9, if you aren't certain of the syntax, use the dsquery user command.

11 Select the following options:
¢ Enable Schedule

¢ Run Immediately
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¢ Every Day
¢ Repeat Every 0.25 Hours

Enable schedule
Run immediately
=7 Schedule
Every Day

© Weekly (on selected days)

] T T O

Sun Mon Tue Wed Thu Fri Sat

© atTime 12[+]: 15[¢] GMT

Repeat Every  0.25 E Hours

12 Select the following options for user synchronization:
¢ Synchronize User Profiles
¢ Register LDAP User Profiles Automatically

Users

Synchronize user profiles
Register LDAFP user profiles automatically
[[] Delete users that are not in LDAP

[ when deleting users, delete associated user workspaces and content

13 Click Apply.

All of the users in the testusers container are added.

LDAP Synchronization Results
Status: Completed

Added Users: 9 B
agreen (cn=a green,ou=testusers dc=filr-lab dc=local)
agray (cn=a gray,ou=testusers,dc=filr-lab,dc=local)
ablack (cn=a black ou=testusers,dc=filr-lab,dc=local)
ayellow (cn=a yellow ou=testusers, dc=filr-lab dc=local)
ared (cn=a red ou=testusers dc=filr-lab,dc=local)
ablue (cn=a blue ou=testusers dc=filr-lab dc=local)
apink (cn=a pink ou=testusers dc=filr-lab dc=local)
filrproxyuser (cn=filr proxyuser,ou=testusers,dc=filr-lab,dc=lacal)
aorange (cn=a orange ou=testusers dc=filr-lab dc=local)

m

14 Click Close.
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[ cose |

15 Remove the filrproxyuser by doing the following:

15a In the left frame, click User Accounts.

= 4 Management

File Upload Limits
Groups

Just-In-Time Sync
License

Manage Shares

Met Folders

Met Folder Servers
Personal Storage
Personal Storage Quotas

Search Index

User Accounts

15b Select Filr Proxyuser.

= Full Name

A Gray

A Green

A Orange

A Pink

ARed

A Yellow

Email Posting Agent
File Sync Agent

Filr Proxyuser

Guest

(N [ i o s R R I o s R

15c¢ Click More, then select Purge Users and their Workspaces.
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More =

Disable User
Enable User

Disable Personal Storage
Enable P nal Storage
Use Global Personal Storage Setting

Purge Users and their Workspaces. ..

space Share Rights. ..
p Application Settings...
Mobile Application Settings...

15d Click Yes.

Are you sure you want to delete and immediately purge the
selected users and their workspaces? (Warning: This action
cannot be undone.)

16 Continue with Section 8.2, “Setting Up Users’ My Files Folders,” on page 83.

For complete instructions on using Filr LDAP synchronization, see “Synchronizing Users and
Groups from an LDAP Directory,” in the Nowvell Filr 1.0.1 Administration Guide.

8.2 Setting Up Users’ My Files Folders

1 Under Management > User Accounts, select the check boxes next to the names of the following
users:

+ A Black

+ A Green
¢ A Orange
A Pink

*
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[7] £ Full Hame Type

A Black E 5
[l A Blue - k3
[l admin - (2]
[l A Gray - -
A Green - 5
A Orange - E 3
A Pink - X

2 Click More > Enable Personal Storage.

Mare «

Disable User
Enable User

Disable Personal Storage

Enable Personal Storage

Use Global Personal Storage Setting

3 Continue with Setting Up Net Folders.

8.3 Setting Up Net Folders

¢ Section 8.3.1, “Specifying Net Folder Servers,” on page 84

¢ Section 8.3.2, “Creating Net Folders and Setting Net Folder Access and Sharing Rights,” on
page 89

8.3.1 Specifying Net Folder Servers

Net Folder Servers are connections to shares on Windows file servers. You can set up as many
connections to each file server as needed. For the hands-on lab, you create one Net Folder Server for
each Share defined in “Setting Up the Other Hands-on Exercise Folders and Files” on page 34.

Configuring the Home_Folders Net Folder Server

1 Under Management, click Net Folder Servers.
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o

=~ A  Management

File Upload Limits
Groups

Just-In-Time Sync
License

Manage Shares

MNet Folders

Personal Storage
Personal Storage Quotas
Search Index

User Accounts

2 Four of the users that you synchronized with the Windows server have Home directories on the
server. Therefore, the Net Folder Server for the Home_Folder$ share on your Windows server
(for example, Windows-DC-Home_Folders$), is already created and listed.

IMPORTANT: Although Home folders are technically like other Net Folders in Filr, their
primary role is personal storage. Therefore, they are accessed through My Files rather than
through Net Folders.

3 The Home Net Folder Server is marked with an icon that indicates that its configuration needs
attention.

In the Name column, click the Home_Folders$ server link.

Mame Senver Path

! Windows-DC-Home_Folderss Windows-DC\Home_Folders$

4 One valuable Filr feature is the ability to share files and folders with others who do not have
native file system rights.

This sharing functionality is provided through Net Folder proxy users. However, the “Home”
Net Folder Server has no Net Folder proxy user configured. That is why the yellow icon is
displayed.

You granted the Net Folder proxy user (filrproxyuser) full control of the Home_Folders$ share
in Step 2 on page 18. You simply need to make Filr aware of that assignment.

4a In the Proxy Name field, type the DN of the filrproxyuser.
For example, in the guide’s development environment, this is
cn=filrproxyuser, cn=testusers,dc=filr-lab, dc=local

4b In the Proxy Password field, type the password specified for the filrproxyuser:

For example, NOv311fi!r
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4c Click Test Connection.

MName: Windows-DC-Home_Folderss

The server path must be entered using UNC syntax. For example
For OES, use W\semver ip addresswolume
For Windows, use \W\server ip address\share

Server path: ‘ Windows-DC\Home_Folderss ‘

Proxy name: ||cn=fi|rprom,fuser,cn:users,dc:filr-lab,dc:local| |

Proxy password: |

Test Connection ‘

5 When you click Test Connection, you should see a message that the test succeeded.
Click OK.

Test succeeded

6 Click OK> OK.

The warning icon is removed.

Mame Server Path

[ windows-DC-Home_Folders$ Windows-DC\Home_Folders$

Configuring the Other Net Folder Servers

1 To add Net Folder Servers for the other shares on the Windows server, click Add.

Add Delete Sync
Mame Server Path

[0 windows-DC-Home_Folders$ Windows-DC\Home_Folders$

2 Use the information in Table 8-1 as you add a Net Folder server for each share.
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Table 8-1 Net Folder Servers to Add

Share Field Text
Dev Name Development
Server Path \\windows-server-IP-address\Dev
Proxy Name filrproxyuser DN
For example: cn=filrproxyuser,ou=testusers,dc=filr-
lab,dc=local
filrproxyuser Password For example: NOv3llfilr
IS Name IS
Server Path \\windows-server-IP-address\IS
Proxy Name filrproxyuser DN
For example: cn=filrproxyuser,ou=testusers,dc=filr-
lab,dc=local
Proxy Password For example: NOva3llfilr
Mrktg Name Marketing
Server Path \\windows-server-IP-address\Mrktg
Proxy Name filrproxyuser DN
For example: cn=filrproxyuser,ou=testusers,dc=filr-
lab,dc=local
Proxy Password For example: NOv3llfilr
Sales Name Sales
Server Path \\windows-server-IP-address\Sales
Proxy Name filrproxyuser DN

For example: cn=filrproxyuser,ou=testusers,dc=filr-
lab,dc=local

Proxy Password

For example: NOv3llfilr

2a Type the information for each share in the fields indicated, beginning with Dev. Then click
Test Connection to verify that the information is typed correctly.
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Name: | Development

The server path must be entered using UNC syntax. For example
For OES, use Wserver ip address'wolume
For Windows, use W\server ip address\share

Semver path: ” \windows-server-name\Dev ‘

Proxy name: | filroroxyuser DN |

Proxy password: “ffl'.rpmhyuserpasswarﬂ| |

Test Connection |

Notice that the Net Folder Server names do not necessarily need to mirror the server and
share names.

2b Click OK.

Test succeeded

2c Under Synchronization Schedule, select
¢ Enable Scheduled Synchronization
¢ Every Day
¢ Repeat every 0.25 hours
Then click OK.

Synchronization Schedule

Enahle scheduled synchronization

7 On selected days

B B B B B B @O
Sun Mon Tue Wed Thu Frn Sat

oAt 0 = - 00 « GMT
Repeat every 0.25 - hours

DD

2d Repeat from Step 2 to create Net Folder Servers for the IS, Marketing, and Sales shares.
3 Click Sync.

88 Filr 1.0.1 Hands-on Guide for Windows



Add Delete

MName
Development
IS

Marketing

I L

Sales

Windows-DC-Home_Folders$

When the sync operation completes, Filr has metadata for each Net Folder Server in its database.

4 Continue with Creating Net Folders and Setting Net Folder Access and Sharing Rights.

8.3.2 Creating Net Folders and Setting Net Folder Access and Sharing
Rights

Net Folders are connections to specific directories on Net Folder Servers. You can set up as many Net
Folders as needed. You can also specify a separate and independent synchronization schedule for
each Net Folder.

1 Under Management, click Net Folders.

< A Management

File Upload Limits
Groups

Just-In-Time Sync
License

Manage Shares

Met Folder Servers
Personal Storage
Personal Storage Quotas
Search Index

User Accounts

2 Use the information in Table 8-2 as you create the Net Folders needed for the hands-on exercises.
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Table 8-2 Net Folder Configuration Information

Users with Rights

Name Server Relative Path to Net Folder

Sharing Rights

reviews Development  personnel\reviews ared Allow Access
Internal

comp planning Development  personnel\salaries ared Allow Access

projects Development  projects ared Allow Access
Internal

External

training IS training\quick_starts ablue Allow Access
Internal

Re-share

cool stuff Marketing advertising\brochures ayellow Allow Access
Internal
External
Public

Re-share

projections Sales revenue\projections ablack Allow Access

Internal

2013 tracking Sales revenue\quotas ablack Allow Access

Internal

2a Click Add.

Add Delete Sync

MName Server Mame

Mo Met Folders were found. Press "Add’ to create one.

Although the Home_Folders$ share is Net Folder Server and four users have Home folders,
there are no Net Folders displayed.

Home folders are displayed and managed under My Files rather than Net Folders.

2b Referring to Table 8-2, in the New Net Folder dialog type a name (starting with reviews).
Select the appropriate Net Folder Server, type the relative path for the Net Folder, then click
Test Connection to verify that the information is entered correctly.
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Configuration Synchronization Schedule Data Synchronization

Name: [feviews | |
MNet Folder Server: Development |L| Mew Met Folder Server
Relative path: [personnellieviews|
Test Connection
2¢ Click OK.

Test succeeded

2d Click Index the Contents of This Net Folder and Enable Just-in-Time Synchronization.

Index the contents of this Met Folder.

Enable Just-in-Time synchronization

Maximum age for Just-in-Time results:@ Seconds
Maximum age for ACL Just-in-Time results: Seconds

Although content indexing carries significant processing overhead and should, therefore,
probably not be applied to all Net Folders, the content used in these exercises is so small
that the overhead involved with indexing is miniscule.

2e Click the Rights tab.

In the User or Group field, begin typing the user listed in the table, then select the correct
user.

| Synchronization Schedule Data Synchronization

Add usersigroups and define the rights they have to files in this Net Folder.

User or Group: ‘ |

— [ARed fared)

Mo one has be
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2f In the Grant Rights dialog, set the sharing rights as listed for the folder, then click OK.

Select the rights the recipient will be granted in this Net Folder.

All-::-w access to the Met Folder

Allow the recipient to share items in the Net Folder with:
Intemal Users
External users
Public

Allow the recipient to grant re-share privilege

2g Click OK.

New Net Folder

' Rights ' Synchronization Schedule Data Synchronization

Add users/groups and define the rights they have to files in this Net Folder.

User or Group: | |

Name Rights Type
ared Mo nghts »  User a

2h Click OK, then return to Step 2 for the next Net Folder.

Do you want to sync the Met Folder now?

ok ||| cancel
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2i When all of the Net Folders have been specified, continue with Enabling Sharing.

Mame Server Name Relative Path
2013 tracking Sales revenuelquotas
projections Sales revenue\projections
cool stuff Marketing advertising\brochures
training 1S training\quick_starts
projects Development projects
comp planning Development personnel\salaries
reviews Development personnelireviews

4 4 -Tof7 » K

8.4 Enabling Sharing

Even though you granted sharing rights in the previous section, actually allowing users to share files

and folders requires that you enable sharing for the Filr site.

1 Under System, click Share Settings.

L O, System

Desktop Application
Email

LDAP

Mobile Applications
Reports

Site Branding

User Access

2 In the User or Group field, start to type all, then select All Internal Users.

Select a user or group to add to the list and then grant share rights.

User or Group:

.AII External Users

Mame
: All Internal Users

Mo one has be

3 Click Re-share items and Share with the public, then click OK.
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Recipients will be granted share rights to-
Re-share items
Share with Internal users
Share with "All Internal Users" group

Share with External users

Share with the public

This sets the maximum sharing rights that can be granted anywhere on the system. Re-sharing
and public access are only available if they are actually enabled on the Net Folders.

4 Click OK.

Select a user or group to add to the list and then grant share rights

User or Group:

MName Rights Type

allusers  Internal / External / Public / Re-share / Share with all Internal users ~  Group @

8.5 Setting Guest Access

The hands-on exercises let you access Filr as a user who doesn’t have an account in Filr.

1 Under System, click User Access.

=7 . _ System

™

Desktop Application
Email

LDAP

Mobile Applications
Reports

Share Settings

Site Branding

User Access

2 Select Allow Guest access and Guest access is read-only, then click OK.
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Allow Guest access

Guest access is read only

[¥] Allow external user access through OpenlD

The read-only option prevents public (guest) users from logging comments. This is generally a
good idea in light of the risk of “spam” comments. Comments cannot be removed in this version
of Filr.

3 Continue with Allowing the Desktop Application to Be Deployed.

8.6 Allowing the Desktop Application to Be Deployed

Some of the Filr end user exercises are done through the Desktop Application. To enable the Desktop
Application to be deployed through the Web application:

1 Under System, click Desktop Application.

= . _ System

| Desktop Application

Email

LDAP

Mobile Applications
Reports

Share Settings

Site Branding

User Access

2 Select Be deployed.

In the Auto-update URL field, type https://Filr-appliance-IP-address:8443/desktopapp/,
then click OK.
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8.7

8.7.1

Allow the desktop application to:
[¥] Access Filr

[¥] Cache the user's passwaord

¥/|Be deployed

Synchronize ewery:- 15 | Minutes

Auto-update URL: || https://Filr-appliance-IP-address:8443/desktopapp

Maximum file size that can be synchronized: | 50 | MB

3 Continue with (Optional) Setting Up Email Communication with the Filr VM.

(Optional) Setting Up Email Communication with the Filr VM

The hands-on exercises leverage two of your personal email addresses:

¢ One is assigned to user ared for demonstrating Filr’s notification capabilities.

¢ The other is used for inviting an external user to collaborate on a project.

If you are not interested in email notifications or external sharing as part of the end user exercises,
you can skip all of the remaining sections and steps in this guide that are marked (Email Only).

If you want to experiment with email notifications that originate from Filr, you must complete the
following sections:

¢ Section 8.7.1, “(Email Only) Entering an Email Address for User ared,” on page 96
¢ Section 8.7.2, “(Email Only) Synchronizing ared’s Change with Filr,” on page 99

(Email Only) Entering an Email Address for User ared

1 On the Windows server, click Start > Administrative Tools > Active Directory Users and Computers.
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» All Programs

Remote Desktop Services

Active Directory Administrative Center

Active Directory Domains and Trusts

Active Directory Module for Windows PowerShell
Active Directory Sites and Services

Active Directory Users and Computers

Command Prompt ; f. _'(
1 o,
,____J Motepad
@ Internet Explorer e
~ - Active Directory Users and Documents
Computers
Computer
Metwark
Control Panel

Devices and Printers

Administrative Tools

Help and Support

Run...

I Search programs and files

@J Log off bl

[ 7start :3% E

==

o

SR BOEHE LG SOk E e kS D] B

ADSI Edit

Component Services

Computer Management

Data Sources (ODBC)

DHCP

DNS

Event Viewer

Group Policy Management
Internet Information Services (115) Manager
ISCSI Initiator

Local Security Policy
Performance Monitor

Security Configuration Wizard
Server Manager

Services

Share and Storage Management
Storage Explorer

System Configuration

Task Scheduler

Windows Firewall with Advanced Security
Windows Memory Diagnostic
Windows PowerShell Modules
Windows Server Backup

2 Right-click user ared and select Properties.
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B Active Directory Users and Computers 10| =l

File  Action View Help

EENEE EEEN E R Y

: Active Directory Users and Comput | Name | Type | Description =
| Saved Queries L ABlack User
B &3 fir-dab.local 2 aBle User
~| Builtin 2 ncray Lser
—| Computers ?_‘) A Green User i
:i__| Domain Controllers \1_) A Orange User
| ForeignSecurityPrincipals 5 A Pink User

| Managed Service Accounts
| Users

=]

3_) avellow| COPY--.
2, administ{  Add to a group... Built-in account for adi

42 Alowegy  Disable Account Members in this group
1 - Reset Password... . =
1] | 3 4] | »

Maove. ..

| Open Home Page |
Send Mail

All Tasks 3

Cut
Delete
Rename

Help

3 Type the email address you have chosen to use with these exercises, for example
myusername@examplemail . com.

Dialin I Environment I Sessions I Remate contral
Remote Desktop Services Profile I Personal Virtual Desktop I COM=
General |Mdress I Account I Profile I Telephones I Organization I Member Of

'43) A Red

First name: IA Imitials:

Last name: IHed

Display name: IA Red

Description: I

Office: I

Telephone number: I Cther...
E-mail: irrr:,usemame@exampleman.com

Web page: I Cther...

ok | cancel | Ay | Hen |

4 Click OK, then continue with (Email Only) Synchronizing ared’s Change with Filr.
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8.7.2  (Email Only) Synchronizing ared’s Change with Filr

1 In the Administration Console under System, click LDAP.

<= _ 7 _ System

Desktop Application
Email

2 Select Run immediately.

Enable schedule
Run immediately
= Schedule
@ Every Day

) Weekly (on selected days)

5 T A
Sun Mon Tue Wed Thu Fri Sat

O atTime 00[=]: 00[=] GMT

@ RepeatEvery 0.25[=] Hours

3 Click Apply.

User ared’s profile is modified.

LDAP Synchronization Results

Status: Completed

Added Users: 0

Nane

Modified Users: 1

|ared (cn=a red,cn=users dc=filr-lab,dc=local) |

4 Continue with Chapter 9, “Using Filr,” on page 101.

Administering Filr 99



100 Filr 1.0.1 Hands-on Guide for Windows



9.1

9.11

Using Filr

The Filr end user exercises can be summarized as follows:

-

\

~

5 i ir
W — - [ 4j — —>
0 ' I
You Access Devices and Methods Filr Windows

2008 R2

You use various clients, including mobile devices, to access Novell Filr.
Filr provides access to test folders and files on a Windows server. /

This section guides you through the following tasks:

*

*

*

Section 9.1, “Accessing Filr to Do the Filr End User Exercises,” on page 101
Section 9.2, “Understanding Test Users and Their Roles,” on page 106
Section 9.3, “Exploring Filr Functionality for End Users,” on page 107

Accessing Filr to Do the Filr End User Exercises

You need connections to Filr through the following access points to complete the Filr End User
Exercises:

*

*

*

*

Connecting to Filr through a Browser and Installing the Filr Desktop

A browser

The Filr Desktop Application

A mobile device

Section 9.1.1, “Connecting to Filr through a Browser and Installing the Filr Desktop
Application,” on page 101

Section 9.1.2, “Starting the Filr Desktop Application,” on page 104

Section 9.1.3, “Installing and Starting a Filr Mobile App,” on page 106

Application

To connect through the browser and install the Filr Desktop Application:

1 On the Windows management workstation, start a browser and access the following URL:

https://Filr-appliance-IP-address: 8443

2 If prompted, accept and install the certificate.

Using Filr
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3 Log in as User ID: apink.

Novell. Filr

[C] Sign in using OpeniD

User ID- | ‘
Password: | ‘

|

4 In the upper-right corner, click apink, then select Download Filr Desktop App.

A Pink

View Profile
Personal Preferences

Help

Download Filr Desktop App

Sign out

5 Click the appropriate link for the host workstation, for example, Windows X64 Client.

PRODUCT TYPE DOWNLOADS

(MD5: ecl3faledBecd(964809620e874467836)

|Windnws %64 Client |
(MD5: 44bdc8eScbelb48d42b151bBbBe18alb)

Filr Windows Client e Windows x86 Client

Filr MacOS Client MacOS Client
‘ (MD5: 60dasBb429756aa3cche ] 41f3a055aa9)

6 Save the file.
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File Download - Security Warning

Do you want to run or save this file?

@ Name: MNovellFilrSetup-x64.exe
Type: Application, 14.0MB

From: 192.168.1.110

Run ][ Cancel ]

While files from the Intemet can be useful, this file type can

I\.gj potentially ham your computer. i you do not trust the source, do not
= run or save this software. What 's the rsk?

Save As
@Q'|- Desktop » - |4'ry | | Search Desktop ol
Organize » Mew folder = - (7]
4.7 Favorites = B Libraries s

P Desktop I _d Systemn Folder

4. Downloads
Filr-Win7

| Recent PI
k= Recent Flaces ]% Systern Folder
4 | o Libraries p | Computer

o @ Documents | 5yctem Folder

> J? Music §
» =] Pictures e , Network
> B Videos i k. Systemn Folder :

File name: MovellFilrSetup-x64.exe

m

m

Save as type: [Application

| sawve ||| cancel |

4 Hide Folders

7 When the download completes, click Open Folder.

Download complete

#:

3_,.- Download Complete

MovellFilrSetup-we4.exe from 192,168.1.110

Downloaded: 14.0MB in 6 sec
|| Download to: C:\Users Filr-Wi.. \NovellFirSetupx64 exe

Transfer rate: 2.33IMB/Sec
[] Close this dialog box when download completes

Run

[Open Folder ] [ Close ]
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8 Right-click the downloaded file and select Run as administrator.

Ej NovellFilrSetup-x54.exe |
Al Win32 Cabinet
k Microsoft Corp Open
5

Troubleshoot compatibility

9 Run the installation, accepting the licenses, rebooting the workstation, and so on until the
desktop application is installed.

Depending on your download speed, downloading and installing Microsoft .NET can take a
while.

For additional information, see the applicable Quick Start on the Novell Filr online
documentation site.

10 Continue with Starting the Filr Desktop Application.

9.1.2 Starting the Filr Desktop Application

1 On the Novell Filr welcome screen, click Start.

Welcome to Novell Filr

Synchronize Novell Filr files between your
computer and Filr

Woaork on Novell Filr files offline from anywhere

S

2 In the Server URL field, type https://Filr-appliance-IP-address:8443, type Username:
apink and apink’s Password, then click Next.

104 Filr 1.0.1 Hands-on Guide for Windows


http://www.novell.com/documentation/novell-filr1
http://www.novell.com/documentation/novell-filr1

Account Information
Provide your user credentials to log in to the Novell Filr server.

€ Account Information

Server URL: |https:,‘jl92.168.1.110:8443 |

() Synchronized Folders -
Example: https://filr.mycompany.com

Username:
Password:  [swsasssas

() General Settings

3 Continue through any security warnings.
4 Click Next.

Synchronized Folders
Select the Novell Filr folders to synchronize to your computer

' Account Information

Mame Location Size
chronized Folders
? Sm . {54 My Files 0 bytes
L (:8] Shared with Me 0 bytes

[ Add ] | Remove |

. <prev ||| Nea> || concel |

5 Click Next.

General Settings
Select the folder on your computer where you want Novell Filr files to be synchronized

+ Account Information Filr Felder

+ Synchronized Folders ChUsers\Filr-Win7\Filr
€) General Settings

Start Mowell Filr at login
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9.1.3

106

9.2

6 Click Finish.

Summary
Select the Novell Filr folders to synchronize to your computer

« Account Information Server URL: https://192.168.1.110:8443
v Synchronized Folders Username: apink

v General Settings Filr Folder: ChUszers\Filr-WinT\Filr

Start at login: Yes

Movell Filr Felders to Synchronize

Mame Location Size
(sl My Files 0 bytes
128l Shared with Me 0 bytes

| <Prev | [ cCancel |

A Filr folder is now available in on the workstation (in Windows Explorer or Macintosh Finder).

Installing and Starting a Filr Mobile App

Filr mobile apps are available as free downloads in the Apple App Store, the Google Play App Store,
and the Amazon Appstore for Android.

Download and install the Filr mobile app on the mobile device as you would any other device app.

To access the Filr Mobile App:

1 Start the app in the same way that you start other apps on your mobile device.
2 Login as Username: ablack.

3 Continue with Understanding Test Users and Their Roles.

Understanding Test Users and Their Roles

Table 4-1 lists eight users that have been synchronized from the Windows server to Filr.

As you can see, there are differences in their Home Folder and personal storage allocations (third
column). Most have one or the other, but ablack has both and agray has no personal storage. We will
briefly explore what this means in Section 9.3.1, “My Files—Home Folders and Personal Storage,” on
page 107.

Notice also that only the manager-level users (ared, ablue, and so on) have file system rights on the
Windows server (fourth column). Nevertheless, the hands-on exercises require that files be accessed
by internal and external users who do not have file system rights. We will explore how this is
accomplished in the “sharing” sections, starting with Section 9.3.2, “Internal Sharing,” on page 114.
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9.3

931

Table 9-1 User Roles and Tasks

Role in the FILR-LAB

User Name . .
organization

Home Folder and Personal
Storage

File System Rights on the
Windows Server

ared Development Manager Home folder Full control of Dev share and
directory

apink Developer Personal None

ablue IT Manager Home folder Full control of IT share and
directory

agreen Filr Administrator Personal None

ayellow Marketing Manager Home folder Full control of Mrktg share and
directory

aorange Product Line Manager Personal None

ablack District Manager Home folder Full control of Sales share and
directory

Personal
agray Account Manager None

Exploring Filr Functionality for End Users

After you have completed the setup and administration instructions in this guide, the Filr VMs and
your Windows server are ready for the exercises in the following sections:

¢ Section 9.3.1, “My Files—Home Folders and Personal Storage,” on page 107

¢ Section 9.3.2, “Internal Sharing,” on page 114

¢ Section 9.3.3, “(Email Only) External Sharing,” on page 122

¢ Section 9.3.4, “Public Sharing,” on page 130

¢ Section 9.3.5, “Re-sharing and Searching,” on page 133

¢ Section 9.3.6, “More Things You Can Try,” on page 136

My Files—Home Folders and Personal Storage

The files and folders that users see when they access My Files are illustrated in Figure 9-1 and
demonstrated in the steps that follow the figure.

¢ The top half shows that two storage locations can be assigned to users for their own use—
personal storage on the Filr data disk and/or home storage on a Windows file server.

¢ The bottom half shows how the assigned storage is displayed in My Files, depending on what a

user is assigned.
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Figure 9-1 What Filr Users See in My Files Depends on What Is Set Up for Them

-
My Files
Filer Data Disk NTFS
@ Home Folders
\\\/ | and : ‘
Or ‘
k local.txt remote.txt j
Only Both Only
Filr Storage Home Folder
I My Files I My Files I My Files
‘ local.txt ‘ local.txt ‘ remote.txt
‘ Home
‘ remote.txt
\

In the following steps, take the role and do the steps of the users that are indicated.

1 User ablack is a fan of the Hubble telescope and especially likes this image (http://hubblesite.org/

gallery/wallpaper/pr2007041a).

On the Windows VMware host workstation, open a browser, then select the 1280X1024 link.

2 Right-click the displayed image, then save it to the desktop.
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Save image as...

Copy image URL
Copy image

Open image in new tab

Inspect element

3 On the Windows server, access user ablack’s home folder in Windows Explorer.

.+ Home_Folders = ablack - ISearcha...

[ I ol

Organize *  Indudeinlibrary = 3 = - 0O @

2 ocaloisk €)= name -

| Filr Exerdse Fold
= }. Home_Folders This folder is empty.

1. inetpub
. PerfLogs

~| 4] I Ll

4 Drag and drop (copy) the image from the desktop to ablack’s home folder on the Windows

server.

mvh. - Home_Falders = ablack

Organize * [=|Edt ~ Sharewith = » = - [0 @
& locapsk(c) Al name -

.. Filr Exercise Fold
| Home_Folders
. ablack

. ablue

. ared

Lo ayellow

. inetpub

. PerfLogs :

- [] ] | |

5 In the administrative browser, sign out as user admin.
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admin

2 Administration Console
View Profile
Personal Preferences
Help

Download Filr Desktop App

6 Signin as User ID: ablack.

Novell. Filr

[0 sign in using OpeniD

User |D: | ablack ‘

Password:

EREEREREEE ‘

Forgot your password?

SignIn Enter as guest

7 Click MygFiles and notice the folder named Home. This is ablack’s home folder on the Windows

| B Ol |

server.

My Files Shared with Me Shared by Me Met Folders

124 My Files
Mew Folder.. Add Files... -

[] & Name Cd Size Modified

= - Jul19, 2013 10:34 AM

Refer to Table 4-1 and notice that user ablack has a home Folder and is also assigned personal
storage. In other words, user ablack is an example of the section labeled “Both” in Figure 9-1.
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8 Open the Home folder.

The Hubble image file is there as you would expect it to be.

A Black (ablack)

%2 ]Home @

Mew Folder... Add Files... -
[T & Title | Size
‘I:I n hs-2007-41-a-1280_wallpaper.jpg - C 690 KB

9 Sign out as user ablack.

A Black

A Black
View Profile
Personal Preferences
Help

Download Filr Desktop App

10 Signin as User ID: admin.

Novell. Filr

[C] Sign in using OpenlD

User ID: | ‘
|

Password:

Forgot your password?

11 Access the Administration Console (upper-right corner).
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admin

2 Administration Console

View Profile
Personal Preferences

Help

Sign out

12 Under Management, click User Accounts.

| ,i, Management

File Upload Limits
Groups

Just-In-Time Sync
License

Manage Shares

Met Folders

Met Folder Servers
Personal Storage
Personal Storage Quotas
Search Index

User Accounts

13 Select A Black, then click More and select Purge User Workspaces > Yes.

¢ L5 User Accounts

| Mew | Impor Profiles. .. More =
[l 2 Full Name Disable User
ABlack Enable User

A Blue Disable Personal Storage

admin Enable Personal Storage

O

O

0 administrator
] A Gray
]

A Green

Purge s and their Wao
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14 Click Yes.

Are you sure you want to delete and immediately purge the
waorkspaces of the selected users? (Warning: This action cannot
be undone.)

15 Select A Black again, then click More and select Disable Personal Storage.

B3 User Accounts

Mew Import Profiles...

[l = Fuib Disable User
= A Black Enable User
O AERe Disable Personal Storage
[l admin Enable Personal Storage
Use Global Personal Storage Settin
[l administrator o ) orage g

16 Sign out as user admin, then sign in as user ablack.

17 Notice that the Home folder has disappeared from user ablack’s My Files folder (the up-arrow
left of Home has disappeared) and the Hubble image file is now directly listed as a child.

A Black (ablack)

[[% Home ©

MNew Folder... Add Files... -
] = Title | Size
[ a hs-2007-41-a-1280_wallpaper.jpg - ™ 590 KB

Because you purged and removed the Personal Storage that was assigned to user ablack, user
ablack now fits the definition in the section of Table 4-1 that is labeled “Only Home Folder.”
(Purging ablack’s personal storage had no effect on the Windows server’s file structure or files.)

18 Click the down-arrow next to the image, then select Share.

& a hs-2007-41-a-1280_wallpaper.pg 690 KB

Share.

View Details

Vfirsas Wlnn blne Armnes

19 In the Share with field, type all, select All Internal Users, then click OK.
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fHome Workspace/Personal Workspaces/A Black (ablack)/Home

h hs-2007-41-a-1280_wallpaper.jpg

& Make Public

Share with: | all |'°'

|f-‘ll| Internal Users |
[Name ] Mote

This item has not be

[¥] Motify: Mew and

20 Click OK.

@ Viewer

) Editor

Allow the recipient to re-share this item with:
[T Internal users

[Tl External users
[C] Public @

21 Feel free to explore further if you want to get more experience with Filr’s My Files functionality
and the role that traditional home folders play in that context. Then continue with Internal
Sharing.

9.3.2 Internal Sharing

The exercises in this section demonstrate how Novell Filr users can share files with users who are
internal to your organization.

¢ “User ared Initiates User apink’s Annual Review” on page 114

¢ “User apink Responds to the Annual Review Request” on page 118

¢ “User ared Approves apink’s Annual Review” on page 120

User ared Initiates User apink’s Annual Review

User ared needs to complete the annual review for user apink, but apink doesn’t have file system access
to the review file (apink 2013.doc). Rather than sending the file in email or assigning apink the
required file system trustee rights on the Windows server, ared simply shares the review file with
apink and includes Editor privileges. First, however, ared optionally ensures that email notifications
will be sent when the file changes.

1 Sign in to the Web application as user ared. (This requires that you sign out as user ablack first.)
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Novell. Filr

[0 sign in using OpeniD

User ID: | ared ‘

Password:

Forgot your password?

SignIn Enter as guest

2 Click Shared with Me and notice that the image that ablack shared is listed.

g_ﬂ Shared with Me

[] & Name CJ Shared by

||:| n hs-2007-41-a-1280_wallpaper.jpg - | A Black

IMPORTANT: If you are not experimenting with email notifications, skip to Step 4 and skip all
subsequent steps that are marked (Email only).

3 (Email only) Click A Red in the upper-right corner, then select View Profile.

A Red

A Red

View Profile

Personal Preferences
Help

Download Filr Desktop App

Sign out

When the profile displays, notice that the email address you configured in Active Directory for
user ared is listed.
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A Red

Personal Information

Job Title:

Contact Information

Email: [ myusername@examplemail.com)|

Phone:

Text Messaging Email:

Photos And Images

| No file selected |

4 Click Net Folders > reviews > apink.

Novell. Filr @ @ a

1‘- LT‘:,'J My Files Shared with Me Shared by Me Met Folders

Net Folders
o | reviews| ©

Mew Folder... Add Files... -

1 = Title ] Size Author

=l D apink +

5 Click the check box for apink_2013.doc, then click the file drop-down arrow « to the right of
the file and select Share.

F n apink_2013.doc . 11 KB

6 In the Share with field, type p, then select A Pink.

E apink_2013.doc
fHome Workspace/Met Folders/reviews/apink
Share with: “E

A Pink (apink)

Name T Filr Proxyuser (filrproxyuser)

7 Select Editor, then click OK
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0 Viewer

Editor

8 Click OK.

9 (Email only) Click the check box for apink_2013.doc and the file drop-down arrow again, then
click Subscribe.

9 apink_2013.doc

Share.__
View Details

View HTML

View Who Has

Rename File_ ..

Subscribe__.

10 (Email only) Expand the Message Only option, then select the email address you entered for user
ared in Directory and click OK.

Mowell Filr will send an email or text message when activity occurs in
a file, folder, or comment. Select addresses to subscribe.

=24 apink_2013.doc
E {Home Workspace/Met Folders/reviews/apink

Message Type: @)
[ ]Message only

myusername@examplemail.com

[ Message with Attachments
[ Text Message

m Cancel

11 Click the comment icon

12 Add a comment, such as
Hi pink.
Would you please edit this with your objectives and achievements and let me
know when you have finished?

Thanks.
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Hi pink.

Would you please edit this with your objectives and let me know when you
have finished.

Thanks.

red

Comments are viewable by all users with access rights
4 : e Send

13 Click Send and close the Comments dialog.

User apink Responds to the Annual Review Request

1 On the Windows 7 VM desktop in the notifications area, right-click the Filr icon.

2 Select Open Filr folder.

Latest sync: Today, 2:49:22 PM

Open Filr folder

Open Filr console

Visit Filr on the Web

Shared by Me
What's New

Synchronize now

Logout

About Movell Filr
Help

Exit

3 Double-click Shared with Me.

) e e

€% FE v | 43 W Search Fitr 0

Organize - Mew folder =~ 0O @
< Favorites Narme Date modified Size
B Desktop i) My Files 1/17/2013 4:53 Ph
& Downleads @ Shared with Me 7/19/2013 2:19 PN
&), Movell Filr desktop.ini 1/17/2013 4:53 Ph.. 1KE

“Zl Recent Places
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4 Right-click apink_2013.doc, then select Open.

[ apink_2013.doc
desktop.ini
=] hs-2007-41-a-1280

Mew
Print

Open with

Share with

Restore previous versions

The file should open in LibreOffice Writer, assuming the prerequisites are met for the Windows

workstation.

5 Make a few changes, then save and close the file.

You can be as verbose or brief as you want.

6 In the Shared with Me folder on the workstation, right-click the file you just edited and select

Synchronize now.

| (& apink_2013.doc

desktop.ini

(o= hs-2007-41-3-1280_wallpay

Open
MNew

Print
Open with

Share with

Restore previous versions

View in a web browser
Share...
Subscribe...

eeoe

Synchronize now |

7 Sign in to the Web application as user apink

Novell. |

[T Sign in using OpenlD

User ID: |

Password:

Forgot your password?

Erere e

8 Click Shared with Me.
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9 Click the drop-down arrow for apink 2013 .doc, then click View HTML.

[ 9 apink_2013.doc -

m n hs-2007-41-a-1280_wallpaper.jpy ikt
View HTML

View Who Has Act

Subscribe. ..

Your changes are reflected in the view.
10 Close the HTML view.

11 Click the review file’s comment icon, type a comment indicating that the review is ready, then
click Send and close the comment panel.

f apink 2013.doc

l A Red
' Jul 19, 2013 2:32:23 PM MOT
T Hipink.
Would you please edit this with your objectives and let me know when you have

Actions =

finished.
Thanks.
red
| | Ive included my input. =

m Comments are viewable by all users with access rights

12 Continue with User ared Approves apink’s Annual Review.

User ared Approves apink’s Annual Review

1 Log in to the email account that you assigned to user ared, open the message from filr-admin,
then click the Visit Message link.
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+ Reply + Replyall =+ Forward 2 Move

From: <filr-admin@filr-lab.local> Friday - July 19, 2013 5:20 P
Subject: [Subscription:Mew] Re: apink_2013.doc

A Pink 119 2013 7:18:32 PMEDT Visit M _

Folder: raviews / zpink
3. Re:apink 2013.doc ew)
APink ull9 2013 7:18:32 PMEDT

DESCRIPTION

I've included my input.
pink

EELATED ENTEY

Folder: reviews / apink

apink 2013 doc
File Sync Agent Tul 17, 2013 3:27:24 BM EDT
Modified by File Sync Agent Jul 19, 2013 7:02:00 PM EDT

ATTACHMENTS
apink_2013.doc Jul 19, 2013 11KB File Sync Agent

2 Sign in to the Web application as user ared.

The message from apink is displayed.

Re: apink_2013.doc

F’_'F apink_2013.doc
E Re: apink_2013.doc

fHome Workspace/MNet Folders/reviews/apink

&= ~
'8 APINK Jul19,20135:18PM Modified: Jul 19, 2013 5:18 PM

Hide I've included my input.
pink

3 In the new comment box, type a comment indicating that the review is approved, then click
Send.

~ Comments (0) +« | + | Cloy
' g | |Looks good. Thanks. g
red

Comments are viewable by all
users with access rights
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4 Close the view.

5 Continue with (Email Only) External Sharing.

9.3.3 (Email Only) External Sharing

The exercises in this section demonstrate how Filr users can share files with users who are external to
your organization.

¢ “About External Users” on page 122

¢ “User ared Gathers Input for the Next Release” on page 122

¢ “User opaque Self-Provisions and Responds to the Review Request” on page 125

¢ “User ared Responds to User opaque’s Input” on page 128

IMPORTANT: Completing the instructions in Section 8.7, “(Optional) Setting Up Email
Communication with the Filr VM,” on page 96 is required for the exercises in this section.

About External Users

External users are those who receive share invitations through email and subsequently provision
themselves as system users. They can then log in to the system using the credentials they establish
with Filr, or they can elect to be authenticated through a Google or Yahoo Open ID account.

For more information about the different kinds of users who can access Filr, see “Users and Groups
with Filr” in the How Filr Works—Querview Guide.

User ared Gathers Input for the Next Release

User ared managed the ABC product release and is responsible for gathering input for the upcoming
XYZ product. User ared also wants to invite input from a key partner named M Opaque. Inviting M
Opagque to participate requires using the second email address mentioned in Chapter 2, “Hands-on
System Requirements,” on page 9 and further explained in Section 8.7, “(Optional) Setting Up Email
Communication with the Filr VM,” on page 96.

1 If you aren’t already signed in to the Web application as user ared, do so now.

2 Click Net Folders > projects > current.

Net Folders projects View What's MNew '[j
5] current @

Mew Folder... Add Files... @) Fitter List [~ 1]

F = Title (] Size Date

] ﬂ abc_reqr.doc 10 KB Jun 25, 2013 2:36 PM

3 Click the check box for abc_regr. doc, then click the file drop-down arrow = to the right of the
file and select Share.
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9 abc_reqr.doc

View Details

View HTML

View Who Has Ad

Rename File...

Subscribe. ..

4 In the Share with field, type your second email address, then click the plus sign (+) to add the
external user.

'Share (1 tems)
E abc_reqr.doc
Home Workspace/Met Folders/projects/current
Share with: ||pubIic—user@examplemail.com ||£|
MName Type Access Expires Note

This item has not been shared.

Notify: MNew and modified recipients =

Cox | come

At this point, user ared could share the document with internal or other external users, but for
brevity’s sake, we aren’t including steps for that.

5 Click OK > OK.

6 Click the check box for abc_regr.doc and the file drop-down arrow again, then click Subscribe.

9 abc_regr.doc

View Details
Wiew HTML

View Who Has Ac

Rename File...

Subscribe.

7 Expand the Message only option, then select the email address you entered for user ared in
Directory and click OK.
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Movell Filr will send an email or text message when activity occurs in
a file, folder, or comment. Select addresses to subscribe.

E abc_reqr.doc
{Home Workspace/Net Folders/projects/current

Message Type: @
[ |Message only

myusername@examplemail.com

[ Message with Attachments

[» Text Message

8 Click the commenticon - - to the right of the down-arrow.
9 Add a comment, such as
It’s time to gather input for the next release.

Please log comments to let us know which features we need to include this time.

Then click Send.

E' abc_reqr.doc (0) Comments

{4

T It's time to gather input for the next release.
Please log comments to let us know which features we need to include this| [

fime.

Send Comments are viewable by all users with access rights

1

10 Close the Comments dialog.

124 Filr 1.0.1 Hands-on Guide for Windows



abc_reqr.doc (1) Comments

A Red Actions -

Jul 22, 2013 12:08:58 PM MDT

It's time to gather input for the next release.
Please log comments to let us know which features we need to include this time.

Send

Comments are viewable by all users with access rights

11 Continue with User opaque Self-Provisions and Responds to the Review Request.

User opaque Self-Provisions and Responds to the Review Request

1 Log in to the email account that you used to invite user opaque to participate in the review.

2 Open the message from the email address that you assigned to user ared and click the
abc_reqr.doc link.

A Red has invited you to access anitem & B

(abc_reqr.doc) nbox
myusername@exar 1139 AM (1 hour ago) “- -
to [+

A Red shared

is share never expires
Movella Filr

- .
Click here to Reply or Forward

3 The registration dialog lets external users register or log in as a guest.

Register as M Opaque by typing First name: M, Last name: Opaque, Password: F1lrrocks, and Re-
enter password: Fllrrocks.

The User ID (email address) cannot be changed.
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Please enter the following information and then click on the

Register button.

| User ID:

public-user@examplemail.com |

First name: “E |
Last name: ‘ |
Password: ‘ |
Re-enter password: ‘ |

Or

To authenticate using google, click on this image  Google

Erer s gues

4 Open the confirmation email, then click Sign in and access shared items.

Your access to the item is confirmed ]
Inbox =
myusername@exar :01 PM (8 minutes ago) - -
to [«

Your access to the item is confirmed
[Sign in and access shared items |
MovellaFilr

Click here to Reply or Forward

5 Type the password F1lrrocks, then click Sign in.
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[T Sign in using OpenlD

User ID: ‘ public-user@examplemail.com |

Passward: ‘ |

Forgot your password?

Enter as guest

6 Click Comments and read the comment from user ared.

~  Comments (1)

A Red
Jul 22, 2013 12:08:58 PM MDT

Actions -

E——

It's time to gather input for the next
release.

Please log comments to let us know which
features we need to include this time.

7 Click Actions, then click Subscribe.

A Red
Jul 22, 2013 12:08:58 PM MDT

It's time to gather input for the n
release.

Please log comments to let us "
features we need to include this time.

Emails will now be sent to user opague as others comment on the document or perform other
actions.

8 Read the HTML view of ABC Project.

abc_regr.doc
Wiew Details

Wiew HTML

View Who Has Ac

Subscribe. .

9 Log the following comment, then click Send.

Competing products have had morning coffee functionality for over 18 months
now.

If the next release doesn’t include this, we will be forced to switch.
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abc_reqr.doc - 1] 10 KB

| ARed Actions =

Jul 22, 2013 12:08:58 PM MDT

It's time to gather input for the next release.
Please log comments to let us know which features we need to include this time.

L]

I | Competing products have had morning coffee functionality for over 18

w | months now.
If the next release doesn't include this, we will be forced to Bwitch.l

« [ »

send Comments are viewable by all users with access rights

10 Continue with User ared Responds to User opaque’s Input.

User ared Responds to User opaque’s Input

User ared receives notification of user opaque’s comment (you can check ared’s email if you wish) and
remembers that the requested feature has been discussed. It should already be in the next
requirements document (xyz_reqr.doc), but ared isn’t certain that it is.

1 Log in to the Web application as user ared.

2 Click Net Folders > projects > future.

3 Click the file drop-down arrow = for xyz_reqr.doc and select View HTML.

The file has not been updated.
4 Click the file drop-down arrow = again, then select View details.

| a xyz_reqr.doc

View Details

View HTML

View Who Has Acc

Rename File_ ..

Subscribe. ..

5 Click Edit this file, then continue past the security warning and other messages until you are
prompted to log in.
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B xyz_reqr.doc
E Home Workspace/Met Folders/projects/future

lw wl -
Ll File Sync Agent Jul17, 2013 1:33 P Modified: Jul 17,

Share... Edit This File Mare«

XYZ Project

Requirement 1
This product will do everything that ABC does.

6 Log in as user ared.
7 Insert the following text before the period:

, and it will make the morning coffee

XYZ Project

Requirement 1
This product will do everything that ABC does, and it will make the morning coffed.

8 Save the file and close LibreOffice.

9 Navigate to xyz_regr.doc again and view its details to confirm that the change has been made.

B2 xyz_reqgr.doc
E Home Workspace/MNet Folders/projects/future

Z File Sync Agent Jul 17, 2013 1:33 PM

I §l
. ARed Modified: Jul22, 2013 2:28 PM

Share... Edit This File More =

XYZ Project

Requirement 1
This product will do everything that ABC does, and it will make the moming coffee.

10 Log and send a comment indicating that the file has been updated.
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~  Comments (0)

' l ' [ The requirements have been updated &
per Opague's comment |

Send Comments are viewable by all

users with access rights

11 Log a comment for the abc_regr.doc file that Opaque’s requirement has been included in the
next version.

abc_reqr.doc {2) Comments

L | ARed Actions -
Jul 22, 2013 12:08:58 PM MDT

It's time to gather input for the next release.
Please log comments to let us know which features we need to include this time.

: M Opaque Actions =
Jul 22, 2013 1:37:07 PM MDT

Competing products have had moming coffee functionality for over 18 months
now.

If the next release doesn't include this, we will be forced to switch.

' ! | | Opaque, Thanks for the input. =
The morning coffee requirement has been added for the next version.

Send Comments are viewsble by all users with access rights

12 Continue with Public Sharing.

9.3.4  Public Sharing

User ayellow wants to get the word out about the abc version of the organization’s product and elicits
the help of user aorange with the effort.

1 Log in to the Web application as User ID: ayellow.
2 Click Net Folders > cool stuff.

Net Folders View What's New m
(1] cool stuff @

Mew Folder... Add Files... @) Fiter List [+ T3]

< Title L Size

o[L] abe_fiyer.pdf - ) 7K
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3 C(lick the file drop-down arrow = for abc_flyer.pdf, then select Share.

] 9 abc_flyer.pdf

View Details

View Who Has Ac

Rename File_ ..

Subscribe. ..

4 In the Share with field, type o, then select A Orange.

@l
| A Orange (aorange) |

5 Click Public > OK > OK.

Grant Share Rights

@ Viewer
) Editor
Allow the recipient to re-share this item with:

[ Internal users
[] External users

6 Log in as User ID: aorange.
7 Click Shared with Me.

@_j Shared with Me

[l £ Name
= ll abc_flyer.pdf -
= ll hs-2007-41-a-1280_wallpaper.jpg -

8 Click the action drop-down for the abc_flyer.pdf file, then click Share.
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[ £ Name

[ 9 abc_flyer.pdf

& e hs-2007-41-a-1280_wallpaper.jpg

View Details

View Who Has

Subscribe._.

9 Click Make Public.

/g; abc_flyer.pdf

mam| Home Workspace/Met Folders/cool stuff

& Make Public

10 In the Type column, click Public to view and copy the URLs that can be shared in social media,
and so on.

Make Item Public

abc_flyer.pdf
fHome Workspace/MNet Folders/cool stuff

Use the following url to view the file entry, abc_flyer_pdf
| https://1 92.‘168.1.11U:8443fssf!a!cfp_namefss_forum!p_actionﬁfacti‘

Use the following url to download the file, abc_flyer pdf
| https:/{192.168.1.110:8443/ssf/s/readFile/folderEntry/6/4 02881 ee3fe4

11 Enter one of the URLs in a separate browser window or tab, then click Enter as Guest to see what
Internet users who access the URL will see.
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9.35

[0 sign in using OpenlD

User ID: ‘

Passwaord ‘

Forgot your password?

Signin Enter as guest

12 Continue with Re-sharing and Searching.

Re-sharing and Searching

1 Log in to the Web application as User ID: ablue.

2 In Net Folders, navigate to training > Novell-Filr.pdf, then share the file with agreen as a Viewer

with rights to reshare the file with internal users.

MNet Folders

(T3] training ©

Mew Folder...
[ = Title

F n Novell Filr.pdf

Add Files...

[9]

A Gray (agray)

A Green (agreen)

L1 Size

Share...
View Details
View Who Has Ac

Rename File_ ..

Subscribe...
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rant Share Rig
@ Viewer
0 Editor

Allow the recipient to re-share this item with:
Internal users

3 Login as user agreen, then share the file (with rights to reshare) with users apink, ayellow, aorange,
ablack, and agray.

Shared with Me

-

£ Name | Shared by
g abc_fiyer.pdf

g@ hs-2007-41-a-1280_wallpaper,jpg

o Hovell Filr.pdf

4
L
b

-4

o

1}

&) Novell Filr.pdf
| Home Workspace/Met Folders/training

Share with: | ‘
MName Type Access
agray User Viewer ~
ablack User Viewer =
7 Viewer
aorange User Viewer = o o )
- Allow the recipient to re-share this item with:
ayellow User Viower Intemal users
apink User Viewer =

Motify: Mew and modified recipients
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A few days after user agreen has shared the file, user apink is talking with user ared in the hallway and

mentions the file.

1 Log in as user ared, then in the search field, type quick and press Enter.

Q qIJil::l':

Search quick
@ Search Entire Site
Search My Files
Search Met Folders
Search Shared with Me

[Mo results]

Search

Because the file is not found, user ared asks apink to share the file.

2 Log in as user apink and share the file with ared.

+H] Shared with Me

[ 2 Hame

[ R abc_flyer.pdf
[ n apink_2013.0dt doc

F n Novell Filr.pdf

-

F n hs-2007-41-a-1280_wallpaperjpy -

-

(] Shared by

Share...

View Details

View Who Has Ac

Subscribe._ ..

A Ora

A Red

ABla

A Gre

1]

A Red (ared)

@ Vigwer

Internal users

Allow the recipient to re-share this item with:
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9.3.6
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3 Log in as user ared and search for the file again.

The file is listed in the search results window.

Search quick

@ Search Entire Site
Search My Files
Search Met Folders
Search Shared with Me
Search Current Folder: Home

Include Sub-Folders

Search results [ 1-1 of 1 ]

léa| Movell Filr.pdf
Maowvell Filr pdf
Met Folders I training
1 File Sync Agent  Jun 25, 2012 2:28 PM

More Things You Can Try

There are a few additional files in the other Net Folders that you can experiment with as indicated
below. You can also experiment with your own files.

Activity Type Net Folder

File Location

Task Descriptions

Planning comp planning  2014.xls

1.

User ared opens the file in LibreOffice and plans a
5.5% increase for apink’s 2014 salary.

Planning projections fy_2014.xls

User ablack shares the file with user agray as a
viewer and asks whether the goals are realistic.

User agray comments that the Q3 estimate is low and
the Q4 estimate is high. User agray asks that $10,000
be transferred from Q4 to Q3.

User ablack adjusts the Q3 and Q4 estimates, thanks
agray, and acknowledges the change.

Reporting guotas fy_2013.xls

User ablack shares this file with user agray as an
Editor and requests that agray update it with Q4
actual results.

User agray opens the file, enters $110,900, and saves
the file.

User agray comments that the file is now ready for
review.
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